User Guide

Guide D’utilisation

Benutzerhandbuch

Guida dell’utente

Guía del usuario

Guia do Usuário

Gebruikershandleiding

Руководство пользователя

Przewodnik użytkownika

Felhasználói útmutató

Uživatelská příručka

Kullanım Kılavuzu

Brugervejledning

Οδηγός χρήσης

Brukerhåndbok

Käyttöopas

Användarhandbok
# Contents

## 1. Introduction
- Special Features ................................................................. 1.1
- Printer Components ............................................................ 1.2
  - Front View ................................................................. 1.2
  - Rear View ................................................................. 1.2
- Understanding the Control Panel ........................................... 1.3
  - LEDs ................................................................. 1.3
  - Stop() button .......................................................... 1.3

## 2. Setting Up Your Printer
- Unpacking ................................................................. 2.1
- Installing the Toner Cartridges ............................................ 2.2
- Loading Paper ............................................................... 2.3
  - Changing the Size of the Paper in the Tray .................... 2.5
- Connecting a Printer Cable .................................................. 2.6
  - For Local Printing ...................................................... 2.6
  - For Network Printing (Phaser 6110N only) ..................... 2.6
- Turning the Printer On ......................................................... 2.7
- Printing a Demo Page ......................................................... 2.7
- Installing the Printer Software ............................................. 2.7
  - System Requirements .................................................. 2.8
  - Printer Driver Features ................................................ 2.8

## 3. Using Print Materials
- Choosing Paper and Other Materials ...................................... 3.1
  - Type and Capacities ...................................................... 3.1
  - Guidelines for Paper and Special Materials .................... 3.1
- Verifying the Output Location .............................................. 3.2
- Loading Paper ............................................................... 3.2
  - Using the Tray .......................................................... 3.2
  - Using Manual Feed Mode ........................................... 3.2
- Printing on Special Print Materials ...................................... 3.3
  - Printing on Envelopes .................................................. 3.3
  - Printing on Labels ....................................................... 3.3
  - Printing on Transparencies .......................................... 3.4
  - Printing on Preprinted Paper ....................................... 3.4
  - Printing on Card Stock or Custom-sized Materials ........... 3.5

## 4. Basic Printing
- Printing a Document .......................................................... 4.1
- Canceling a Print Job ........................................................ 4.1
5. Supplies and maintenance items
   Printing a Configuration Page .............................................................. 5.1
   Replacing supplies and maintenance items ............................................ 5.1
   Managing Toner Cartridges ................................................................. 5.2
      Toner Cartridge Storage ................................................................. 5.2
      Toner Cartridge Life Expectancy ..................................................... 5.2
      Redistributing Toner ..................................................................... 5.2
   Replacing Toner Cartridges ................................................................. 5.3
   Replacing the Imaging Unit ................................................................. 5.4
   Replacing the Waste Toner Container .................................................. 5.6
   Cleaning the Printer .......................................................................... 5.7
      Cleaning the Outside of the Printer .................................................. 5.7
      Cleaning the Inside of the Printer ................................................... 5.7

6. Solving Problems
   Troubleshooting Checklist .................................................................. 6.1
   Solving General Printing Problems ..................................................... 6.2
   Clearing Paper Jams .......................................................................... 6.3
      Tips for Avoiding Paper Jams .......................................................... 6.5
   Solving Print Quality Problems .......................................................... 6.5
   Troubleshooting Error Messages ......................................................... 6.8
      LED status legend ......................................................................... 6.8
   Common Windows Problems ............................................................... 6.8
   Common Macintosh Problems ............................................................. 6.8
   Common Linux Problems .................................................................. 6.9

7. Using Your Printer on a Network
   About Sharing the Printer on a Network ............................................. 7.1
   Setting Up a Network-Connected Printer (Phaser 6110N only) ............... 7.1

8. Specifications
   Printer Specifications ........................................................................... 8.1
   Paper Specifications ........................................................................... 8.1
      Overview ....................................................................................... 8.1
      Supported Sizes of Paper ............................................................... 8.2
      Guidelines for Using Paper ............................................................ 8.2
   Paper Specifications ........................................................................... 8.3
   Paper Output Capacity ...................................................................... 8.3
   Paper Input Capacity ........................................................................ 8.3
   Printer and Paper Storage Environment .............................................. 8.3
   Envelopes ......................................................................................... 8.3
   Labels .............................................................................................. 8.4
Important Precautions and Safety Information

When using this machine, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to people:

1. Read and understand all instructions.
2. Use common sense whenever operating electrical appliances.
3. Follow all warnings and instructions marked on the machine and in the literature accompanying the machine.
4. If an operating instruction appears to conflict with safety information, heed the safety information. You may have misunderstood the operating instruction. If you cannot resolve the conflict, contact your sales or service representative for assistance.
5. Unplug the machine from the AC wall socket before cleaning. Do not use liquid or aerosol cleaners. Use only a damp cloth for cleaning.
6. Do not place the machine on an unstable cart, stand or table. It may fall, causing serious damage.
7. Your machine should never be placed on, near or over a radiator, heater, air conditioner or ventilation duct.
8. Do not allow anything to rest on the power. Do not locate your machine where the cords will be abused by persons walking on them.
9. Do not overload wall outlets and extension cords. This can diminish performance, and may result in the risk of fire or electric shock.
10. Do not allow pets to chew on the AC power or PC interface cords.
11. Never push objects of any kind into the machine through case or cabinet openings. They may touch dangerous voltage points, creating a risk of fire or shock. Never spill liquid of any kind onto or into the machine.
12. To reduce the risk of electric shock, do not disassemble the machine. Take it to a qualified service technician when repair work is required. Opening or removing covers may expose you to dangerous voltages or other risks. Incorrect reassembly could cause electric shock when the unit is subsequently used.
13. Unplug the machine from the PC and AC wall outlet, and refer servicing to qualified service personnel under the following conditions:
   - When any part of the power cord, plug, or connecting cable is damaged or frayed.
   - If liquid has been spilled into the machine.
   - If the machine has been exposed to rain or water.
   - If the machine does not operate properly after instructions have been followed.
   - If the machine has been dropped, or the cabinet appears damaged.
   - If the machine exhibits a sudden and distinct change in performance.
14. Adjust only those controls covered by the operating instructions. Improper adjustment of other controls may result in damage, and may require extensive work by a qualified service technician to restore the machine to normal operation.
15. Avoid using this machine during a lightning storm. There may be a remote risk of electric shock from lightning. If possible, unplug the AC power for the duration of the lightning storm.
16. If you continuously print multiple pages, the surface of the output tray may become hot. Be careful not to touch the surface, and keep children away from the surface.
17. SAVE THESE INSTRUCTIONS.

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere, is certified as a Class I laser product conforming to the requirements of IEC 825.

Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to laser radiation above a Class I level during normal operation, user maintenance, or prescribed service condition.

**WARNING**

Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, can damage your eyes.

When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:
Ozone Safety

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is advisable that the machine be operated in a well ventilated area. If you need additional information about ozone, please contact your nearest Xerox dealer.

Power Saver

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use. When the printer does not receive data for an extended period of time, power consumption is automatically lowered.

Recycling

Please recycle or dispose of packaging materials for this product in an environmentally responsible manner.

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European countries with separate collection systems)

This marking shown on the product or its literature, indicates that it should not be disposed with other household wastes at the end of its working life. To prevent possible harm to the environment or human health from uncontrolled waste disposal, please separate this from other types of wastes and recycle it responsibly to promote the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and how they can take this item for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the purchase contract. This product should not be mixed with other commercial wastes for disposal.

Radio Frequency Emissions

FCC Regulations

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
- This device may not cause harmful interference, and
- This device must accept any interference received, including interference that may cause undesired operation.

This device has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to operate the equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Declaration of Conformity (European Countries)

Approvals and Certifications

The CE marking applied to this product symbolises Xerox Corporation. Declaration of Conformity with the following applicable 93/68/EEC Directives of the European Union as of the dates indicated:


A full declaration, defining the relevant Directives and referenced standards can be obtained from your Xerox Corporation representative.

Replacing the Fitted Plug (for UK Only)

IMPORTANT

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until you have another fuse cover.

Please contact the people from you purchased the machine. The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

WARNING

If you cut off the moulded plug, get rid of it straight away. You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

IMPORTANT WARNING: You must earth this machine.

The wires in the mains lead have the following colour code:

• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colours marked in your plug, do the following:

You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety 'Earth symbol' or coloured green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter "N" or coloured black.

You must connect the brown wire to the pin which is marked with the letter "L" or coloured red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.
1 Introduction

Congratulations on the purchase of your printer!

This chapter includes:
• Special Features
• Printer Components
• Understanding the Control Panel

Special Features

Your new printer is equipped with several special features that will improve print quality. You can:

Print in colour with excellent quality and speed
• You can print in a full range of colours using cyan, magenta, yellow, and black.
• You can print up to 2400 x 600 dpi (effective output). For details, see the Software Section.
• Your printer prints A4-sized paper at 16 ppm in black and white mode and 4 ppm in colour mode.

Use multiple types of media easily

Create professional documents
• Print Watermarks. You can customize your documents with a watermark, such as the word “Confidential.” For details, see the Software Section.
• Print Posters. The text and pictures of each page of your document can be magnified and printed across several sheets of paper and taped together to form a poster. For details, see the Software Section.
• Print Booklets. This feature enables you to easily print a document to create a book. Once printed, all you have to do is fold and staple the pages. For details, see the Software Section.

Save time and money
• You can print multiple pages on a single sheet of paper to save paper.
• You can manually print on both sides of the paper (Manual double-sided printing) in Windows and Macintosh. For details, see the Software Section.
• You can use preprinted forms and letterhead. For details, see the Software Section.
• This printer automatically conserves electricity by substantially reducing power consumption when not printing.

Print in various environments

You can print in Windows 98/Me/NT 4.0/2000/2003/XP. Windows NT 4.0 is only supported on the Phaser 6110N.
• Your printer is compatible with Macintosh and various Linux OS.
• Your printer comes with a USB interface.
• The Phaser 6110N comes with a built-in Network interface, 10/100 Base TX. The Phaser 6110 does not support a network interface.
**Printer Components**

These are the main components of your printer. Note that all illustrations on this User’s Guide are from the Phaser 6110N and that some parts may be different from your printer.

**Front View**

- **Output Tray** (Face down)
- **Top Cover** (Open to clear paper jams.)
- **Front Cover** (Open to access the toner cartridges and imaging unit.)
- **Output Support**
- **Tray** (150-sheet paper feeder)
- **Control Panel** (See 1.3.)
- **Handle** (Use to lift the printer.)
- **Toner Cartridges**

**NOTE:** The surface of the output tray may become hot if you print a large number of pages at once. Please make sure that you don’t touch the surface, and prevent children from approaching it.

---

**Rear View**

- **Power Receptacle**
- **Rear Cover** (Open to clear paper jams.)
- **USB Port**
- **Network Port** *
- **Power Switch**

* Only the Phaser 6110N comes with a network port.
Understanding the Control Panel

### LEDs

<table>
<thead>
<tr>
<th>Status LED( ), Toner LEDs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lights green, all LEDs off</td>
<td>The printer is ready to print.</td>
</tr>
<tr>
<td>slowly blinks green, all LEDs off</td>
<td>The printer is receiving data from the computer.</td>
</tr>
<tr>
<td>fast blinks green, all LEDs off</td>
<td>The printer is printing data.</td>
</tr>
</tbody>
</table>
| lights red, all LEDs off | • The printer is experiencing an error, such as jammed paper, open cover, empty paper, not installed waste toner container, or full waste toner container.  
• The printer is experiencing a service required error, such as LSU error, fuser error, or ITB error. Contact your sales or service representative. |
| lights green, each LED blinks red | The each colour toner cartridge is near the end of its life. |
| blinks red, each LED lights red | The each colour toner cartridge is empty. |

**NOTE:** All printing errors will be appear in the Status Monitor program window.

### Stop( ) button

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printing demo page</strong></td>
<td>In Ready mode, press and hold this button for about 2 seconds until the LED blinks fast, and release.</td>
</tr>
<tr>
<td><strong>Printing configuration sheets</strong></td>
<td>In Ready mode, press and hold this button for about 5 seconds until the LED blinks fast, and release.</td>
</tr>
<tr>
<td><strong>Canceling print job</strong></td>
<td>Press this button during printing. The red LED blinks while the print job is cleared from both the printer and the computer, and then the printer returns to Ready mode. This may take some time depending on the size of the print job.</td>
</tr>
</tbody>
</table>
Setting Up Your Printer

This chapter gives you step-by-step instructions for setting up your printer.

This chapter includes:
• Unpacking
• Installing the Toner Cartridges
• Loading Paper
• Connecting a Printer Cable
• Turning the Printer On
• Printing a Demo Page
• Installing the Printer Software

Unpacking

1. Remove the printer and all of the accessories from the packing carton. Make sure that the printer has been packed with the following items:

- Toner Cartridges
- Power Cord
- Printer software CD
- Quick Install Guide

NOTES:
- If any items are missing or damaged, notify your dealer immediately.
- **Components may differ from one country to another.**
- The Printer Driver CD contains the printer driver, the SetIP, the User’s Guide, and the Adobe Acrobat Reader program.
- The appearance of the power cord may differ depending on your country’s specifications. The power cord must be plugged into a grounded power socket.

CAUTION: Because your printer weighs 13.6 kg including the toner cartridges and the tray, it may move when you use it; for example, when opening/closing the tray or installing/removing the toner cartridge. Be careful not to move the printer.

2. Remove the packing tape in front of the tray and pull the tray out. Remove the packing tape and paper cushion from the tray.

3. Select a location for the printer:
   - Leave enough room to open the tray and covers, and to allow for proper ventilation.
   - Provide the proper environment:
     - A firm, level surface
     - Away from the direct airflow of air conditioners, heaters, or ventilators
     - Free of temperature, sunlight, and humidity extremes or fluctuations
     - Clean, dry, and free of dust

CAUTION: You must place your printer on a level surface. If you do not, print quality problems can occur.
CAUTION: If you have to move the printer laid a side or upside down, remove the waste toner container from the printer and move it separately. Or the inside of the printer may be contaminated.

Installing the Toner Cartridges

1. Open the front cover.

2. Pull and remove the paper protecting the imaging unit.

3. Remove four dummy caps which are on the toner cartridge entrances of the imaging unit.

4. Remove the toner cartridges from their bags.

5. Holding the toner cartridges, shake thoroughly them from side to side to distribute the toner.

6. Remove the cartridges cap.

NOTE: If toner gets on your clothing, wipe it off with a dry cloth and wash it in cold water. Hot water sets toner into fabric.

7. On the imaging unit of the printer, labels identify which colour cartridge goes into each cartridge slot.
8 Grasp the toner cartridges and align them with the slots inside the printer. Insert them into their corresponding slots until they click into place.

9 Close the front cover. Make sure that the cover is securely closed.

**CAUTION**: If the front cover is not completely closed, the printer will not operate.

**NOTE**: When printing text at 5% coverage, you can expect a toner cartridge life of about 2,000 pages for black and white printing and 1,000 pages for colour printing. However, the toner cartridge that is shipped with the printer prints 1,500 pages for black and white, 700 pages for colours.

---

## Loading Paper

The tray can hold a maximum of 150 sheets of 20 lb (75 g/m²) plain paper. You can use various paper including plain paper.

To load paper:

1. Pull the tray out of the printer.
2. Open the paper cover.
3. Adjust the size of tray until it sounds click.
4. Enlarge the tray by adjusting the paper width guide.
5. Flex the paper sheets back and forth to separate the pages and then fan them while holding one edge. Tap the edges of the stack on a flat surface to even it up.

6. Load paper **with the print side up**.

   ![Image of paper being loaded into tray]

   Make sure not to overfill the tray and that all four corners are flat in the tray and under the brackets, as shown below. Overfilling the tray may cause a paper jam.

   ![Image of tray with paper being loaded and adjusted]

   **NOTE:** If you want to change the size of the paper in the tray, refer to “Changing the Size of the Paper in the Tray” on page 2.5.

7. Squeeze the paper length guide and slide in it until it lightly touches the end of the paper stack.

   ![Image of paper length guide being adjusted]

8. Close the paper cover.

9. Slide the tray back into the printer.

   ![Image of tray being slid back into printer]

   **NOTE:** After you load paper, you need to set up your printer for the paper type, size, and source you loaded. For details, see the **Software Section**.
Changing the Size of the Paper in the Tray

To change the tray size to other size, you must adjust the paper length guide properly.

1. Pull the tray out of the printer. Open the paper cover and remove paper from the tray if necessary.

2. Pressing and unlatching the guide lock in the top of the tray, pull the tray out manually.

3. Load paper into the tray.

4. Slide the paper length guide until it lightly touches the end of the paper stack. Squeeze the paper width guide and slide it to the edge of the paper stack without causing it to bend.

For paper smaller than Letter-sized, return the paper guides to their original positions and adjust the paper length guide and paper width guide.

NOTES:
- Do not push the width guide far enough to cause the material to warp.
- If you do not correctly adjust the width guide, it may cause a paper jam.

5. Close the paper cover.

6. Slide the tray back into the printer.
Connecting a Printer Cable

For Local Printing

To print from your computer in a local environment, you need to connect your printer to the computer with a Universal Serial Bus (USB) cable.

**NOTE**: Connecting the printer to the USB port of the computer requires a certified USB cable. You will need to buy a USB 2.0 compliant cable that is not longer than 3 m.

1. Make sure that both the printer and the computer are turned off.
2. Plug the USB cable into the connector on the rear of the printer.
3. Connect the other end of the cable to the USB port on your computer.

**NOTE**: To print using the USB interface, you must run Windows 98/Me/2000/2003/XP or Macintosh with OS 10.3 ~10.4.

For Network Printing (Phaser 6110N only)

You can attach your printer to a network using an Ethernet cable (UTP cable with RJ.45 connector). The Phaser 6110N has a built-in network interface card.

1. Make sure that both the printer and the computer are turned off.
2. Plug one end of the Ethernet cable into the Ethernet network port on the rear of the printer.
3. Plug the other end of the cable into a network LAN connection.

**NOTE**: After connecting the printer, you need to configure the network parameters using the software supplied with the printer.
Turning the Printer On

1. Plug the power cord into the power receptacle on the rear of the printer.
2. Plug the other end into a properly grounded AC outlet and turn on the power.

**CAUTION:** If there is a cracking sound, re-install the imaging unit. The imaging unit is not properly installed.

**CAUTION:**
- Some parts inside the printer may be hot when power is on, or after printing. Be careful not to burn yourself when working inside the printer.
- Do not disassemble the printer when it is turned on or plugged in. Doing so may give you an electric shock.

**NOTE:** Each LED blinks red in a repeated order. Wait for about 1.5 minutes for the printer to get ready.

Installing the Printer Software

**You must install software using the supplied printer driver CD after you have set up your printer and connected it to your computer. For details, see the Software Section.**

The printer driver CD provides you with the following software:

**Programs for Windows**

You can install the following printer software using the printer driver CD.

- **Printer driver** for Windows. Use this driver to take full advantage of your printer’s features. See the Software Section for details about installing the Xerox printer driver.
- **Status Monitor**. Appears when printing errors occur. See the Software Section for details about installing the Status Monitor program.
- **Printer Settings Utility**. You can configure print settings.

**Macintosh Printer Driver**

You can print from a Macintosh with your printer. Go to the Software Section for information about installing the print software and printing from a Macintosh.

**Linux Driver**

You can print from a Linux-based computer with your printer. Go to the Software Section for information about installing the Linux driver and printing from a Linux environment.

Printing a Demo Page

Print a demo page to make sure that the printer is operating correctly.

To print a demo page:

In Ready mode, press and hold the \( \text{on}/\text{off} \) button for 2 seconds.

A demo page showing the printer’s features and capabilities is printed.
System Requirements

Before you begin, ensure that your system meets the minimum requirements. Your printer supports the following operating system.

- Windows 98/Me/NT 4.0/2000/XP/2003 - The following table shows Windows requirements.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 98/Me/NT 4.0/2000/XP/2003</td>
</tr>
<tr>
<td>RAM</td>
<td>98/Me</td>
</tr>
<tr>
<td></td>
<td>NT 4.0/2000</td>
</tr>
<tr>
<td></td>
<td>XP</td>
</tr>
<tr>
<td></td>
<td>2003</td>
</tr>
<tr>
<td>Free Disk Space</td>
<td>98/Me/NT 4.0/2000/XP/2003</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>5.0 or higher</td>
</tr>
</tbody>
</table>

**NOTES:**
- For Windows NT 4.0/2000/XP/2003, the system administrator should install the software.
- Windows NT 4.0 is only supported on the Phaser 6110N.

- Macintosh 10.3 ~10.4 - For details, see the Software Section.
- Various Linux OS - For details, see the Software Section.

Printer Driver Features

Your printer drivers will support the following standard options:
- Paper source selection
- Paper size, orientation, and media type
- number of copies

The table below lists a general overview of features supported by your printer drivers.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Printer driver</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Win98/Me/NT 4.0/2000/XP/2003</td>
</tr>
<tr>
<td>Colour Mode</td>
<td>Y</td>
</tr>
<tr>
<td>Black &amp; White</td>
<td>Y</td>
</tr>
<tr>
<td>Print Quality Option</td>
<td>Y</td>
</tr>
<tr>
<td>Poster Printing</td>
<td>Y</td>
</tr>
<tr>
<td>Manual Double-sided Printing</td>
<td>Y</td>
</tr>
<tr>
<td>Multiple Pages Per Sheet (N-up)</td>
<td>Y</td>
</tr>
<tr>
<td>Fit to Page Printing</td>
<td>Y</td>
</tr>
<tr>
<td>Scale Printing</td>
<td>Y</td>
</tr>
<tr>
<td>Booklet Printing</td>
<td>Y</td>
</tr>
<tr>
<td>Watermark</td>
<td>Y</td>
</tr>
<tr>
<td>Overlay</td>
<td>Y*</td>
</tr>
</tbody>
</table>

* The Overlay feature is not supported in NT4.0.

**NOTE:** For details about installing software and using its features, see the Software Section.
Choosing Paper and Other Materials

You can print on a variety of print materials, such as plain paper, envelopes, labels, card stock, and so on. See “Printing on Special Print Materials” on page 3.3. To get the best possible print quality, use only high-quality, copier-grade paper.

When you choose print materials, consider the following:

- **Desired outcome**: The paper you choose should be appropriate for the project.
- **Size**: You can use any size paper that fits easily within the paper adjusters of the tray.
- **Weight**: Your printer supports paper weights as follows:
  - 16~24 lbs bond (60~90 g/m²) for the tray
  - 16~43 lbs bond (60~163 g/m²) for the manual feed mode
- **Brightness**: Some papers are whiter than others and produce sharper, more vibrant images.
- **Surface smoothness**: The smoothness of the paper affects how crisp the printing looks on the paper.

**CAUTION**: Using a material that does not conform to the specifications listed on page 8.3 can cause problems that may require service. This service will not be covered by the warranty or service agreements.
Verifying the Output Location

The printer has the output tray that collects paper face-down, in correct order.

**NOTES:**
- If you continuously print many pages, the surface of the output tray may become hot. Be careful not to touch the surface, and especially keep children away from the surface.
- The output tray can hold up to 100 sheets of paper. Remove the pages so that the tray is not overloaded.

Loading Paper

Proper paper loading helps prevent paper jams and ensures trouble-free printing. Do not remove the tray while a job is printing. Doing so may cause a paper jam. See “Type and Capacities” on page 3.1 for acceptable paper capacities for tray.

Using the Tray

Tray can hold a maximum of 150 sheets of plain A4 or letter-sized paper. It can also hold 1 sheet of special material, such as cards, envelopes, labels, and transparency.

To load paper, pull the tray and load the paper with the print side up.

For details about loading paper in the tray, see “Loading Paper” on page 2.3.

If you want to print on previously printed paper, the printed side should be facing up with the uncurled edge toward the printer. If you experience problems with the paper feeding, turn the paper around.

Using Manual Feed Mode

If you select **Manual Feed** in the Source option, you can manually load paper in the tray. Manually loading paper can be helpful when you want to check the print quality after each page is printed.

If you experience a paper jam from the tray, load one sheet of paper at a time into the tray.

1. Load the print material in the tray with the print side up.

2. Adjust the paper guide against the print material without bending the paper.

3. When you print a document, you must select **Manual Feed** for Source from the software application, and then select the correct paper size and type. For details, see **Software Section**.

4. Press the button on the printer to start feeding.

**NOTE:** If you do not press the button after a pause, the paper will be automatically fed into the printer.

5. Printing is started.

If you are printing multiple pages, load the next sheet after the first page prints out, and press the button. Repeat this step for every page to be printed.
Printing on Special Print Materials

Printing on Envelopes

- Only use envelopes recommended for your printer. Before loading envelopes in the tray, make sure that they are undamaged and are not stuck together.
- Do not feed stamped envelopes.
- Never use envelopes with clasps, snaps, windows, coated linings, or self-stick adhesives.

To print on envelope:

1. Squeeze the paper length guide and slide it out to its full length.
2. Load a sheet of envelope in the tray, with the flap side down. The end of the envelope with the stamp area enters the printer first.
3. Slide in the paper length guide until it lightly touches the end of the paper stack.
4. Slide the paper width guide to the edge of the envelope without causing it to bend.

**CAUTION:** If you print 20 envelopes in succession, the surface of the top cover may become hot. Please exercise caution.

5. When you print, set the paper source to Manual Feed and the paper type to Envelope, and select the appropriate size in the software application. For details, see the Software Section.
6. Press the button on the printer to start feeding.

Printing on Labels

- Only use labels recommended for your printer.
- Verify that the labels’ adhesive material can tolerate a fusing temperature of 180 °C (356 °F) for 0.1 seconds.
- Make sure that there is no exposed adhesive material between the labels. Exposed areas can cause labels to peel off during printing, which can cause paper jams. Exposed adhesive can also cause damage to printer components.
- Never print on the same sheet of labels more than once, or print on a partial sheet of labels.
- Do not use labels that are separating from the backing sheet or are wrinkled or damaged in any way.
- To prevent labels from sticking together, do not let the printed label sheets stack up as they are printed out.

To print on label:

1. Squeeze the paper length guide and slide it out to its full length.
2. Load a sheet of label in the tray, with the print side up and the top, short edge in first. Adjust the guides to fit the length and width of the label.

3. When you print, set the paper source to Manual Feed and the paper type to Labels, and select the appropriate size in the software application. For details, see the Software Section.
4. Press the button on the printer to start feeding.
Printing on Transparencies

• Place them on a flat surface after removing them from the machine.
• Do not leave them in the tray for long periods of time. Dust and dirt may accumulate on them resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle them and coated paper carefully.
• To avoid fading, do not expose the printed transparencies to prolonged sunlight.

**Caution:** It is not recommended to use paper-backed transparencies such as Xerox 3R91334, which can cause a jam or be scratched.

To print on transparency:

1. Squeeze the paper length guide and slide it out to its full length.
2. Load a sheet of transparency in the tray, **with the print side up and the top, short edge in first**. Adjust the guides to fit the length and width of the transparency.
3. When you print, set the paper source to **Manual Feed** and the paper type to **Transparency**, and select the appropriate size in the software application. For details, see the **Software Section**.
4. Press the **Enter** button on the printer to start feeding.

Printing on Preprinted Paper

• Preprinted paper is paper that has some type of printing on it before it is sent through the printer (paper that has a preprinted logo at the top of the page, for example).
• Letterhead must be printed with heat-resistant ink that will not melt, vaporize, or release hazardous emissions when subjected to the printer’s fusing temperature of 180 °C (356 °F) for 0.1 seconds.
• Ink on letterhead must be non-flammable and should not adversely affect printer rollers.
• Forms and letterhead should be sealed in moisture-proof wrapping to prevent changes during storage.
• Before you load preprinted paper, such as forms and letterhead, verify that the ink on the paper is dry. During the fusing process, wet ink can come off of preprinted paper, reducing the print quality.

To print on preprinted paper:

1. Squeeze the paper length guide and slide it out to its full length.
2. Load letterhead in the tray, **with the print side up and the top and short edge first**. Adjust the guides to fit the edge of the paper stack.
3. When you print, set the paper source to **Manual Feed** and the paper type to **Preprinted**, and select the appropriate paper size in the software application. For details, see the **Software Section**.
4. Press the **Enter** button on the printer to start feeding.
Printing on Card Stock or Custom-sized Materials

- Postcards, 3in by 5in (index) cards, and other custom-sized materials can be printed with your printer. The minimum size is 3in by 5in (76mm by 127mm) and the maximum size is 8.5in by 14in (216mm by 356mm).

- Always insert the short edge into the tray first. If you want to print in landscape mode, make this selection using your software. Inserting these materials long edge first may cause a paper jam.

- Do not print on material smaller than 3in (76mm) wide or 5in (127mm) long.

- In the software application, set margins at least 4mm away from the edges of the material.

To print on card stock:

1. Squeeze the paper length guide and slide it out to its full length.

2. Load print material in the tray, **with the print side up and the short edge first**. Adjust the guides to fit the length and width of the material.

3. When you print, set the paper source to **Manual Feed** and select the appropriate size and type in the software application. For details, see the **Software Section**.

   If the size of your print material is not listed in the **Size** box in the **Paper** tab, click the **Custom** button and set the size manually.

4. Press the **on/off** button on the printer to start feeding.

**NOTE**: If you experience jams with card stock feeding, turn the paper around and try again.
This chapter explains common printing tasks.

- **Printing a Document**
- **Canceling a Print Job**

---

### Printing a Document

This printer allows you to print from various Windows applications, a Macintosh computer, or a Linux system. The exact steps for printing a document may vary depending on the application you use.

For details about printing, see the [Software Section](#).

### Canceling a Print Job

If the print job is waiting in a print queue or print spooler, such as the printer group in Windows, delete the job as follows:

1. Click the Windows **Start** button.
2. For Windows 98/NT 4.0/2000/Me, select **Settings** and then **Printers**.
   - For Windows XP/2003, select **Printers and Faxes**.
3. Double-click the **Xerox Phaser 6110 Series** icon.
4. From the **Document** menu, select **Cancel Printing** (Windows 98/Me) or **Cancel** (Windows NT 4.0/2000/XP/2003).

**NOTE:** You can also access this window by simply double-clicking the printer icon at the bottom right corner of the Windows desktop.

You can also cancel the current job by pressing the **Start** button on the control panel of your printer.
This chapter provides information for maintaining your printer and the toner cartridges.

This chapter includes:
- **Printing a Configuration Page**
- **Replacing supplies and maintenance items**
- **Managing Toner Cartridges**
- **Replacing Toner Cartridges**
- **Replacing the Imaging Unit**
- **Replacing the Waste Toner Container**
- **Cleaning the Printer**

### Printing a Configuration Page

You can print a configuration page from the printer's control panel. Use the configuration page to view the current settings, to help troubleshoot problems.

To print a configuration page:

In Ready mode, press and hold the button on the control panel for 5 seconds.

A configuration page prints out.

### Replacing supplies and maintenance items

From time to time, you need to replace the following items to maintain top performance and to avoid print quality problems resulting from worn parts.

The following items should be replaced after you have printed the specified number of pages or when the life span of each item has expired. The Status Monitor program window will appear on the computer, indicating which item needs to be replaced.

- **Black toner cartridge**: Approx. 2,000 pages*
  - **Region List A**: 106R01203
  - **Region List B**: 106R01274
- **Colour toner cartridges**: Approx. 1,000 pages*
  - **Region List A**:
    - Cyan: 106R01206
    - Magenta: 106R01205
    - Yellow: 106R01204
  - **Region List B**:
    - Cyan: 106R01271
    - Magenta: 106R01272
    - Yellow: 106R01273
- **Imaging unit**: Approx. 20,000 black pages or approx. 50,000 images
  - **Region List A**: 108R00721
  - **Region List B**: 108R00744
- **Waste toner container**: Approx. 5,000 images** or Approx. 1,250 pages (full colour 5% image)
  - **Part number**: 108R00722
- **Pick-up roller**: Approx. 50,000 pages
- **Fuser unit**: Approx. 100,000 black pages or 50,000 colour pages
- **T2 roller**: Approx. 100,000 pages
- **ITB**: Approx. 60,000 images

* Average A4-/letter-sized page count based on 5% coverage of individual colours on each page. Usage conditions and print patterns may cause results to vary.

**Image counts based on one colour on each page. If you print documents in full colour (Cyan, Magenta, Yellow, Black), the life of this item will be reduced by 25%.

**Region List A**: Algeria, Argentina, Bulgaria, Bermuda, Brazil, Caribbean(excluding Puerto Rico and the US Virgin Islands), Central America, Chile, Colombia, Czech. Republic, Croatia, Cyprus, Ecuador, Egypt, Estonia, Gibraltar, Hungary, India, Latvia, Lithuania, Malta, Mexico, Middle East, Morocco, Nigeria, Oman, Pakistan, Paraguay, Peru, Poland, rest of Africa, rest of South America, Romania, Russia/CIS, Slovakia, Slovenia, South Africa, Sri Lanka, Tunisia, Turkey, Ukraine, Uruguay, Venezuela

**Region List B**: Austria, Belgium, Canada, Denmark, Finland, France, Germany, Greece, Ireland, Italy, Netherlands, Norway, Portugal, Puerto Rico, Spain, Sweden, Switzerland, UK, USA, rest of Benelex region

To purchase replacement parts, contact your Xerox dealer or the retailer where you bought your printer. We strongly recommend that items be installed by a trained service professional, except for the toner cartridges (see 5.3), the imaging unit (see 5.4), and the waste toner container (see 5.6).

If you use refilled toner cartridges, print quality may be reduced.
Managing Toner Cartridges

Toner Cartridge Storage
To get the maximum results from a toner cartridge, keep the following guidelines in mind:
- Do not remove toner cartridges from their packages until you are ready to use them.
- Do not refill toner cartridges. **The printer warranty does not cover damage caused by using a refilled cartridge.**
- Store toner cartridges in the same environment as the printer.
- To prevent damage to toner cartridges, do not expose them to light for more than a few minutes.

Toner Cartridge Life Expectancy
The life of a toner cartridge depends on the amount of toner that your print jobs require. When printing text at 5% coverage, the toner cartridges last an average of 2,000 pages for black and white printing and 1,000 pages for each colour printing. However, the toner cartridge that is shipped with the printer prints 1,500 pages for black and white, 700 pages for colours.

Redistributing Toner
When a toner cartridge is low on toner, faded or light areas may appear. It is also possible that coloured images may be printed with incorrect colours due to flawed mixing of toner colours when one of the coloured toner cartridges is low on toner. The Status Monitor program window appears on the computer telling you which colour cartridge is low on toner. Also, when the toner LED, on the control panel, indicating each individual toner cartridge according to its colour, blinks, the toner cartridge is low.

The printer is able to continue to print using the current toner cartridge until the Status Monitor program window appears on the computer telling you to replace the cartridge.

You may be able to temporarily improve print quality by redistributing the toner.

To redistribute the toner:
1. Open the front cover.
2. Pull the corresponding toner cartridge out to remove from the printer.
3. Holding the toner cartridge, shake thoroughly it from side to side to redistribute the toner.
4 Grasp the toner cartridge and align it with the corresponding slot inside the printer. Insert it back into its slot until it clicks into place.

**NOTE:** If toner gets on your clothing, wipe it off with a dry cloth and wash it in cold water. Hot water sets toner into fabric.

5 Close the front cover. Make sure that the cover is securely closed.

---

**Replacing Toner Cartridges**

The printer uses four colours and has a different toner cartridge for each one: yellow (Y), magenta (M), cyan (C), and black (K).

When the Toner LED, on the control panel, indicating each individual toner cartridge according to its colour, lights, and the Print/Stop LED lights red, the toner cartridge is totally exhausted. Your printer stops printing.

Also, the Status Monitor program window appears on the computer telling you to replace the cartridge.

**NOTE:** The print quality may get poor if the refilled toner cartridge is installed, since its characteristics may significantly differ from the genuine.

To replace the toner cartridge:

1 Turn the printer off, then wait a few minutes for the printer to cool.

2 Open the front cover.

3 Pull the corresponding toner cartridge out to remove from the printer.

4 Take a new toner cartridge out of its package.

5 Holding the toner cartridge, shake thoroughly it from side to side to distribute the toner.

6 Remove the cartridges cap.
NOTE: If toner gets on your clothing, wipe it off with a dry cloth and wash it in cold water. Hot water sets toner into fabric.

7 Grasp the toner cartridge and align it with the corresponding slot inside the printer. Insert it into its slot until it clicks into place.

8 Close the front cover. Make sure that the cover is securely latched, and then turn the printer on.

CAUTION: If the front cover is not completely closed, the printer will not operate.

NOTES:
- Each LED blinks red in a repeated order. Wait for about 1.5 minutes for the printer to get ready.
- When printing text at 5% coverage, you can expect a toner cartridge life of about 2,000 pages for black and white printing and 1,000 pages for colour printing. However, the toner cartridge that is shipped with the printer prints 1,500 pages for black and white, 700 pages for colours

Replacing the Imaging Unit

The life of the imaging unit is approximately 20,000 pages for black or 50,000 images. When the life span of the imaging unit has expired, the Status Monitor program window appears on the computer, indicating the imaging unit needs to be replaced. Otherwise your printer stops printing.

To replace the imaging unit:

1 Turn the printer off, then wait a few minutes for the printer to cool.

2 Open the front cover.

3 Remove all of the toner cartridges and waste toner container from the printer.

4 Pull the imaging unit out of the printer using the handle on its bottom.
5. Extend the top handle on the imaging unit and then use it to pull the imaging unit out of the printer completely.

6. Take a new imaging unit out of its package. Remove the protective devices on both sides of the imaging unit and the paper protecting the surface of the imaging unit.

**CAUTION:**
- Don’t use sharp objects, such as a knife or scissors, to open the imaging unit package. You could damage the surface of the imaging unit.
- Be careful not to scratch the surface of the imaging unit.
- To prevent damage, do not expose the imaging unit to light for more than a few minutes. Cover it with a piece of paper to protect it if necessary.

7. Holding the handles on the new imaging unit, push the imaging unit until it sounds ‘click’ in to the printer.

8. Remove four dummy caps which are on the toner cartridge entrances of the imaging unit.

9. Insert the toner cartridges and waste toner container into their corresponding slots until they click into place.

10. Close the front cover firmly.

**CAUTION:** If the front cover is not completely closed, the printer will not operate.

11. Turn the printer on.

**CAUTION:** If there is a cracking sound, re-install the imaging unit. The imaging unit is not properly installed.

**NOTE:** Each LED blinks red in a repeated order. Wait for about 1.5 minutes for the printer to get ready.
Replacing the Waste Toner Container

The life of the waste toner container unit is approximately 1,250 pages for full colour 5% image or 5,000 pages for black. When the life span of the waste toner container has expired, the Status Monitor program window appears on the computer, indicating the waste toner container needs to be replaced. Otherwise your printer stops printing.

To replace the waste toner container:

1. Turn the printer off, then wait a few minutes for the printer to cool.
2. Open the front cover.
3. Pull the waste toner container out of the printer using its handle.
4. Remove the container’s cap from the left side of the container as shown below, and use it to close the waste toner container opening.
5. Take a new waste toner container out of its package.
6. Insert the new container into position and then push it to make sure that it is firmly seated in place.
7. Close the front cover firmly.
8. Turn the printer on.

**NOTE:** Make sure that you lay the waste toner container on a flat surface so that the toner does not spill.

**CAUTION:** Do not tilt or turn over the container.

**CAUTION:** If the front cover is not completely closed, the printer will not operate.
Cleaning the Printer

During the printing process, particles of paper, toner, and dust can accumulate inside the printer. Over time, this build-up can cause print quality problems such as toner specks or smearing. Your printer has a cleaning mode that can correct and prevent these types of problems.

Cleaning the Outside of the Printer

Clean the printer cabinet with a soft lint-free cloth. You can dampen the cloth slightly with water, but be careful not to let any water drip onto the printer or inside of it.

**CAUTION:** Cleaning the printer cabinet with cleaners containing large amounts of alcohol, solvents, or other strong substances can discoulour or crack the cabinet.

Cleaning the Inside of the Printer

1. Turn the printer off and unplug the power cord, then wait a few minutes for the printer to cool.
2. Open the front cover.
3. Pull the imaging unit out of the printer using the handle on its bottom.
4. Extend the top handle on the imaging unit and then use it to pull the imaging unit out of the printer completely.
5. Look inside the printer. Remove any dust, paper particles, and spilled toner with a damp, soft lint-free cloth.

**CAUTION:**
- Do not touch the green surface on the imaging unit with your hands or any other material. Use the handle on it in order to avoid touching this area.
- Be careful not to scratch the surface of the imaging unit.
- To prevent damage, do not expose the imaging unit to light for more than a few minutes. Cover it with a piece of paper to protect it if necessary.
6. Pull the imaging unit about half and push it until it sounds 'click'. Repeat this action two or three times.

**NOTE:** After cleaning, let the printer to dry completely.
7 Push the imaging unit until it sounds 'click' in to the printer.

8 Close the front cover firmly.

**CAUTION:** If the front cover is not completely closed, the printer will not operate.

9 Plug the power cord in and turn the printer on.

**CAUTION:** If there is a cracking sound, re-install the imaging unit. The imaging unit is not properly installed.
6 Solving Problems

This chapter provides helpful information for what to do if you encounter an error while using your printer.

This chapter includes:
- Troubleshooting Checklist
- Solving General Printing Problems
- Clearing Paper Jams
- Solving Print Quality Problems
- Common Windows Problems
- Common Macintosh Problems
- Common Linux Problems

Troubleshooting Checklist

If the printer is not working properly, consult the following checklist. If the printer does not pass a step, follow the corresponding troubleshooting suggestions.

<table>
<thead>
<tr>
<th>Status</th>
<th>Response</th>
</tr>
</thead>
</table>
| Make sure that the LED on the control panel green and “Ready” is shown on the Status Monitor program window. | • If the LED is off, check the power cord connection. Check the power switch. Check the power source by plugging the power cord into another outlet.  
• If the LED blinks or lights red, solve the problems. See “Troubleshooting Error Messages” on page 6.8 or, contact your service representative. |
| Print a demo page to verify that the printer is feeding paper correctly. See 2.7. | • If a demo page does not print, check the paper supply in the tray.  
• If the paper jams in the printer, go to “Clearing Paper Jams” on page 6.3. |
| Check the demo page to see if it is printed correctly. | If there is a print quality problem, go to “Solving Print Quality Problems” on page 6.5. |
| Print a short document from a software application to verify that the computer and printer are connected and communicating correctly. | • If the page does not print, check the cable connection between the printer and the computer.  
• Check the print queue or print spooler to see if the printer has been paused.  
• Check the software application to ensure that you are using the proper printer driver and communication port. If the page is interrupted during printing, go to “Solving General Printing Problems” on page 6.2. |
| If completing the checklist does not resolve the printer problem, check the following troubleshooting sections. | • See “Solving General Printing Problems” on page 6.2.  
• See “Solving Print Quality Problems” on page 6.5.  
• See “Common Windows Problems” on page 6.8.  
• See “Common Macintosh Problems” on page 6.8.  
• See “Common Linux Problems” on page 6.9. |
# Solving General Printing Problems

For problems with the operation of your printer, refer to the table for suggested solutions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print.</td>
<td>The printer is not receiving power.</td>
<td>Check the power cord connections. Check the power switch and the power source.</td>
</tr>
<tr>
<td></td>
<td>The printer is not selected as the default printer.</td>
<td>Select <strong>Xerox Phaser 6110 Series</strong> as your default printer.</td>
</tr>
<tr>
<td></td>
<td>Check the printer for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The printer cover is not closed.</td>
<td>Close the printer cover.</td>
</tr>
<tr>
<td></td>
<td>• Paper is jammed.</td>
<td>Clear the paper jam. See 6.3.</td>
</tr>
<tr>
<td></td>
<td>• No paper is loaded.</td>
<td>Load paper. See 2.3.</td>
</tr>
<tr>
<td></td>
<td>• A toner cartridge is not installed.</td>
<td>Install the toner cartridge. See 5.3.</td>
</tr>
<tr>
<td></td>
<td>The printer may be in manual feed mode and out of paper.</td>
<td>Check the message on the Status Monitor program window, add paper to the tray and press the button on the control panel.</td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is not connected properly.</td>
<td>Disconnect the printer cable and reconnect it.</td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is defective.</td>
<td>If possible, attach the cable to another computer that is working properly and try to print a document. You can also try using a different printer cable.</td>
</tr>
<tr>
<td></td>
<td>The port setting is incorrect.</td>
<td>Check the Windows printer setting to make sure that the print job is sent to the correct port. If the computer has more than one port, make sure that the printer is attached to the correct one.</td>
</tr>
<tr>
<td></td>
<td>The printer may be configured incorrectly.</td>
<td>Check the printer properties to ensure that all of the print settings are correct.</td>
</tr>
<tr>
<td>Paper does not feed into the printer.</td>
<td>Paper has been loaded incorrectly.</td>
<td>Remove paper from the tray and reload it correctly. Check that the paper guides are set correctly.</td>
</tr>
<tr>
<td></td>
<td>There is too much paper in the tray.</td>
<td>Remove excess paper from the tray.</td>
</tr>
<tr>
<td></td>
<td>The paper is too thick.</td>
<td>Use only paper that meets printer specifications.</td>
</tr>
<tr>
<td>A print job is extremely slow.</td>
<td>The job may be very complex.</td>
<td>Reduce the complexity of the page(s) or try adjusting the print quality settings. Adjust the print quality settings, such as reducing the resolution. If you have set the resolution to <strong>Best</strong>, change it to <strong>Normal</strong> or <strong>Draft</strong>. See the <strong>Software section</strong>. Your printer prints A4-sized paper at 16 ppm in black and white mode and 4 ppm in colour mode.</td>
</tr>
<tr>
<td></td>
<td>If using Windows 98/Me, the Spooling Setting may be set incorrectly.</td>
<td>From the <strong>Start</strong> menu, choose <strong>Settings</strong> and <strong>Printers</strong>. Right-click the <strong>Xerox Phaser 6110 Series</strong> printer icon, choose <strong>Properties</strong>, click the <strong>Details</strong> tab, and then choose the <strong>Spool Settings</strong> button. Select the desired spool setting.</td>
</tr>
<tr>
<td>Half the page is blank.</td>
<td>The page orientation setting may be incorrect.</td>
<td>Change the page orientation in your application. For details, see the <strong>Software Section</strong>.</td>
</tr>
<tr>
<td></td>
<td>The paper size and the paper size settings do not match.</td>
<td>Ensure that the paper size in the printer driver settings matches the paper in the tray. Or, ensure that the paper size in the printer driver settings matches the paper selection in the software application settings you use.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td>The paper keeps jamming.</td>
<td>There is too much paper in the tray.</td>
<td>Remove excess paper from the tray. Check that the paper guides are set correctly.</td>
</tr>
<tr>
<td></td>
<td>An incorrect type of paper is being used.</td>
<td>Use only paper that meets printer specifications.</td>
</tr>
<tr>
<td></td>
<td>There may be debris inside the printer.</td>
<td>After opening the front cover, remove the imaging unit and then clear the debris.</td>
</tr>
<tr>
<td>The printer prints, but the text is wrong, garbled, or incomplete.</td>
<td>The printer cable is loose or defective.</td>
<td>Disconnect and reconnect the printer cable. Try a print job that you have already printed successfully. If possible, attach the cable and printer to another computer and try a print job that you know works. Finally, try a new printer cable.</td>
</tr>
<tr>
<td></td>
<td>The wrong printer driver was selected.</td>
<td>Check the application’s printer selection menu to ensure that your printer is selected.</td>
</tr>
<tr>
<td></td>
<td>The software application is malfunctioning.</td>
<td>Try printing a job from another application.</td>
</tr>
<tr>
<td></td>
<td>The operating system is malfunctioning.</td>
<td>Exit Windows and reboot the computer. Turn the printer off and then back on again.</td>
</tr>
<tr>
<td>Pages print, but are blank.</td>
<td>The toner cartridge is defective or out of toner.</td>
<td>Redistribute the toner. See page 5.2. If necessary, replace the toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>The file may have blank pages.</td>
<td>Check the file to ensure that it does not contain blank pages.</td>
</tr>
<tr>
<td></td>
<td>Some parts in the printer may be defective.</td>
<td>Contact a service representative.</td>
</tr>
<tr>
<td>When you are using Windows 98, the illustrations print incorrectly from Adobe Illustrator.</td>
<td>The setting in the software application is wrong.</td>
<td>Select Download as Bit Image in the Advanced Options window of the graphic properties window. Print the document again.</td>
</tr>
</tbody>
</table>

### Clearing Paper Jams

**NOTE:** When removing paper that is jammed in the printer, if possible always pull the paper in the direction that it normally moves so as not to damage internal components. Always pull firmly and evenly; do not jerk the paper. If the paper tears, ensure that all fragments of paper are removed; otherwise a jam will occur again.

If a paper jam occurs, the LED on the control panel lights red. Find and remove the jammed paper.

To resume printing after clearing paper jams, you must open and close the front cover or rear cover.

1. Pull the tray out of the printer and remove the jammed paper.

   ![Clearing Paper Jams](image)

   If you cannot find the jammed paper, go to the next step.
2 To remove the jammed paper, open the rear cover.

3 Carefully remove the paper by pulling in the direction as shown below. Most of the jammed paper can be removed in this step. If you cannot find the jammed paper, or if there is any resistance removing the paper, stop pulling and go to the next step.

**NOTE**: If the paper tears, make sure that all of the paper fragments are removed from the printer.

4 Close the rear cover and then open the top cover.

5 Holding the inner cover open, carefully take the jammed paper out of the printer. The inner cover will then close automatically.

**CAUTION**: Do not touch the fuser inside the inner cover. It is hot and could cause burns! The fuser's operating temperature is 180 °C (356 °F). Take care when removing paper from the printer.

6 Close the top cover. Make sure that it is securely closed.

7 Open and then close the rear cover or front cover to resume printing.
Tips for Avoiding Paper Jams

By selecting the correct paper types, most paper jams can be avoided. If a paper jam occurs, follow the steps outlined in “Clearing Paper Jams” on page 6.3.

- Follow the procedures on page 3.2. Ensure that the adjustable guides are positioned correctly.
- Do not overload the tray.
- Do not remove the paper from the tray while printing.
- Flex, fan, and straighten the paper before loading.
- Do not use creased, damp, or highly curled paper.
- Do not mix paper types in a tray.
- Use only recommended print materials. See “Paper Specifications” on page 8.1.
- Ensure that the recommended print side of print materials is facing up in the tray.

Solving Print Quality Problems

Dirt inside of the printer or improper paper loading may reduce print quality. See the table below to troubleshoot problems.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light or faded print</td>
<td>If a vertical white streak or faded area appears on the page:</td>
</tr>
<tr>
<td></td>
<td>- The toner supply is low. You may be able to temporarily extend the toner cartridge life. See “Redistributing Toner” on page 5.2. If this does not improve print quality, install a new toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>- The paper may not meet paper specifications (for example, the paper is too moist or too rough). See “Paper Specifications” on page 8.1.</td>
</tr>
<tr>
<td></td>
<td>- A combination of faded or smeared defects may indicate that the printer needs cleaning. See page 5.7.</td>
</tr>
<tr>
<td>Toner specks</td>
<td>The paper may not meet specifications (for example, the paper is too moist or too rough). See “Paper Specifications” on page 8.1.</td>
</tr>
<tr>
<td>Dropouts</td>
<td>If generally rounded, faded areas occur randomly on the page:</td>
</tr>
<tr>
<td></td>
<td>- A single sheet of paper may be defective. Try reprinting the job.</td>
</tr>
<tr>
<td></td>
<td>- The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper. See “Paper Specifications” on page 8.1.</td>
</tr>
<tr>
<td></td>
<td>- The paper lot is bad. The manufacturing process can cause some areas to reject toner. Try a different kind or brand of paper.</td>
</tr>
<tr>
<td></td>
<td>- The toner cartridge may be defective. See “Vertical repetitive defects” on the next page.</td>
</tr>
<tr>
<td></td>
<td>- Change the printer option and try again. Go to printer properties, click Paper tab, and set paper type to Thick. Refer to the Software Section for details.</td>
</tr>
<tr>
<td></td>
<td>- If these steps do not correct the problems, contact a service representative.</td>
</tr>
</tbody>
</table>
### Vertical lines

If black vertical streaks appear on the page:
- A imaging unit has probably been scratched. Remove the imaging unit and install a new one. See page 5.3.

If white vertical lines appear on the page:
- Clean the inside of the printer. See "Cleaning the Inside of the Printer" on page 5.7. If you still have the same problems, replace the imaging unit with a new one. See page 5.3.

### Colour or Black background

If the amount of background shading becomes unacceptable, the procedures below may fix the problem:
- Change to lighter weight paper. See “Paper Specifications” on page 8.1.
- Check the printer’s environment; very dry (low humidity) or high humidity (higher than 80% RH) conditions can increase the amount of background shading.
- Remove one of the old toner cartridges and install a new one.

### Toner smear

- Clean the inside of the printer. See "Cleaning the Inside of the Printer" on page 5.7
- Check the paper type and quality. See “Paper Specifications” on page 8.1.
- Remove the imaging unit and install a new one. See "Replacing the Imaging Unit" on page 5.4.

### Vertical repetitive defects

If marks repeatedly appear on the printed side of the page at even intervals:
- Clean the inside of the printer. See "Cleaning the Inside of the Printer" on page 5.7. After cleaning the inside of the printer, if you still have the same problems, install a new toner cartridge of the problem colour. See “Replacing Toner Cartridges” on page 5.3.
- Parts of the printer may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after a few more pages.
- The fusing assembly may be damaged. Contact a service representative.

### Background scatter

Background scatter results from bits of toner distributed on the printed page.
- The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that the paper does not absorb too much moisture.
- If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams on the reverse side. Printing on seams can cause problems.
- If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application or via the printer properties window.

### Misformed characters

- If characters are improperly formed and producing hollowed images, the paper stock may be too slick. Try a different paper. See “Paper Specifications” on page 8.1.
- If characters are improperly formed and producing a wavy effect, the printer may need service. Verify that it also occurs on a demo page. See page 2.7. For service, contact a service representative.

### Page skew

- Ensure that the paper is loaded properly.
- Check the paper type and quality. See “Paper Specifications” on page 8.1.
- Ensure that the paper or other material is loaded correctly and the guides are not too tight or too loose against the paper stack.

### Curl or wave

- Ensure that the paper is loaded properly.
- Check the paper type and quality. Both high temperature and high humidity can cause paper curl. See “Paper Specifications” on page 8.1.
- Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

### Wrinkles or creases

- Ensure that the paper is loaded properly.
- Check the paper type and quality. See “Paper Specifications” on page 8.1.
- Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back of printouts are dirty</td>
<td>• Check for leaking toner. Clean the inside of the printer. See “Cleaning the Inside of the Printer” on page 5.7.</td>
</tr>
<tr>
<td>Solid Colour or Black pages</td>
<td>• The toner cartridge may not be installed properly. Remove the toner cartridge and reinsert.</td>
</tr>
<tr>
<td></td>
<td>• The toner cartridge may be defective and need replacing. Install a new toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>• The printer may require repair. Contact a service representative.</td>
</tr>
<tr>
<td>Loose toner</td>
<td>• Clean the inside of the printer.</td>
</tr>
<tr>
<td></td>
<td>• Check the paper type and quality. See “Paper Specifications” on page 8.1.</td>
</tr>
<tr>
<td></td>
<td>• Install a new toner cartridge. See “Replacing Toner Cartridges” on page 5.3.</td>
</tr>
<tr>
<td></td>
<td>• If the problem persists, the printer may require repair. Contact a service representative.</td>
</tr>
<tr>
<td>Character Voids</td>
<td>Character voids are white areas within characters that should be solid black:</td>
</tr>
<tr>
<td></td>
<td>• You may be printing on the wrong surface of the paper. Remove the paper and turn it over.</td>
</tr>
<tr>
<td></td>
<td>• The paper may not meet paper specifications. See page 8.1.</td>
</tr>
<tr>
<td>Horizontal stripes</td>
<td>If horizontally aligned colour or black streaks or smears appear:</td>
</tr>
<tr>
<td></td>
<td>• A toner cartridge may be installed improperly. Remove the toner cartridge and reinsert.</td>
</tr>
<tr>
<td></td>
<td>• A toner cartridge may be defective. Install a new toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>• If the problem persists, the printer may require repair. Contact a service representative.</td>
</tr>
<tr>
<td>Curl</td>
<td>If the printed paper is curled or paper does not feed into the printer:</td>
</tr>
<tr>
<td></td>
<td>• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Change the printer option and try again. Go to printer properties, click Paper tab, and set paper type to Thin. Refer to the Software Section for details.</td>
</tr>
<tr>
<td>An unknown image repetitively appears on a</td>
<td>You printer is probably being used at an altitude of 2,500 m (8,200 ft) or above. The high altitude may affect the print quality such as loose toner or light imaging. You can set this option through Printer Settings Utility or Printer Tab in printer driver’s properties. Refer to the Software Section for detail.</td>
</tr>
<tr>
<td>next few sheets or loose toner, light print,</td>
<td></td>
</tr>
<tr>
<td>contamination occurs.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting Error Messages

When the printer experiences an error, the control panel will indicate an error message with the indicator lights and the Status Monitor program window will display to show the printer’s status or errors. Find the light pattern below that matches the printer light pattern and follow the solutions to clear the error.

**LED status legend**

- symbol for green light on
- symbol for red light blinking
- symbol for red light on
- symbol for light off

<table>
<thead>
<tr>
<th>LED pattern</th>
<th>Possible Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="LED pattern" /></td>
<td>The blinking toner cartridge is low. Order a new toner cartridge. You can temporarily improve print quality by redistributing the toner. See “Redistributing Toner” on page 5.2</td>
</tr>
<tr>
<td><img src="image2" alt="LED pattern" /></td>
<td>The lighting toner cartridge is empty. Remove the old toner cartridge and install a new one. See “Replacing Toner Cartridges” on page 5.3</td>
</tr>
</tbody>
</table>
| ![LED pattern](image3) | • The lighting toner cartridge is totally exhausted. Remove the old toner cartridge and install a new one. See “Replacing Toner Cartridges” on page 5.3  
• The lighting toner cartridge is wrong. Only install a Xerox toner cartridge, designed for your printer. |
| ![LED pattern](image4) | • A paper jam has occurred. To solve the problem, see “Clearing Paper Jams” on page 6.3.  
• The front or top cover is opened. Close the front or top cover.  
• There is no paper in the tray. Load paper in the tray.  
• The waste toner container is not installed or full. Check the container.  
• Your system has some problems. If this problem occurs, contact your service representative. |

### Common Windows Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>“File in Use” message appears during installation.</td>
<td>Exit all software applications. Remove all software from the StartUp Group, then restart Windows. Reinstall the printer driver.</td>
</tr>
<tr>
<td>“General Protection Fault”, “Exception OE”, “Spool32”, or “Illegal Operation” messages appear.</td>
<td>Close all other applications, reboot Windows and try printing again.</td>
</tr>
<tr>
<td>“Fail To Print”, “A printer timeout error occurred.” messages appear.</td>
<td>These messages may appear during printing. Just keep waiting until the printer finishes printing. If the message appears in standby mode or after printing has been completed, check the connection and/or whether an error has occurred.</td>
</tr>
</tbody>
</table>
| The printer does not print PDF file correctly. Some parts of graphics, text, or illustrations are missing. | Incompatibility between the PDF file and the Acrobat products:  
Printing the PDF file as an image may solve this problem. Turn on **Print As Image** from the Acrobat printing options.  
**NOTE:** It will take longer to print when you print a PDF file as an image. |

### Common Macintosh Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause and Solution</th>
</tr>
</thead>
</table>
| The printer does not print PDF file correctly. Some parts of graphics, text, or illustrations are missing. | Incompatibility between the PDF file and the Acrobat products:  
Printing the PDF file as an image may solve this problem. Turn on **Print As Image** from the Acrobat printing options.  
**NOTE:** It will take longer to print when you print a PDF file as an image. |
| The document has printed, but the print job has not disappeared from the spooler in Mac OS 10.3.2. | Update your Mac OS to OS 10.3.3 or higher. |

**NOTE:** Refer to the Microsoft Windows 98/Me/NT 4.0/2000/2003/XP User’s Guide that came with your PC for further information on Windows error messages.
### Common Linux Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some letters are not displayed normally during the Cover page printing.</td>
<td>This problem is caused because Mac OS can not create the font during the Cover page printing. English alphabet and numbers are displayed normally at the Cover page.</td>
</tr>
<tr>
<td>I can't make a printer the system default.</td>
<td>In some conditions, it may not be possible to change the default queue. This happens with some variants of LPRng, especially on recent RedHat systems that use the &quot;printconf&quot; database of queues. When using printconf, the <code>/etc/printcap</code> file is automatically refreshed from the database of printers managed by the system (usually through the &quot;printtool&quot; command), and the queues in <code>/etc/printcap.local</code> are appended to the resulting file. The default queue in LPRng is defined as the first queue in <code>/etc/printcap</code>, and therefore it is not possible for the Linux Printer Package to change the default when some queues have otherwise been defined using printtool. LPD systems identify the default queue as the one named &quot;lp&quot;. Thus, if there is already a queue by this name, and if it doesn't have an alias, then you won't be able to change the default. To work around this, you can either delete the queue or rename it by manually editing the <code>/etc/printcap</code> file.</td>
</tr>
<tr>
<td>I am using BSD lpr (Slackware, Debian, older distributions) and some options chosen in LLPR don't seem to take effect.</td>
<td>Legacy BSD lpr systems have a hard limitation on the length of the option string that can be passed to the printing system. As such, if you selected a number of different options, you may have exceeded the length of the options and some of your choices won't be passed to the programs responsible for implementing them. Try to select fewer options that deviate from the defaults, to save on memory usage.</td>
</tr>
<tr>
<td>The N-up setting does not work correctly for some of my documents.</td>
<td>The N-up feature is achieved through post-processing of the PostScript data that is sent to the printing system. However, such post-processing can only be adequately achieved if the PostScript data conforms to the Adobe Document Structing Conventions. Problems may arise when using N-up and other features that rely on post-processing if the document being printed isn't compliant.</td>
</tr>
<tr>
<td>I am trying to print a document in Landscape mode, but it prints rotated and cropped.</td>
<td>Most Unix applications that offer a Landscape orientation option in their printing options will generate correct PostScript code that should be printed as is. In that case, you need to make sure that you leave the LLPR option set to its default Portrait setting, to avoid unwanted rotations of the page that would result in cropped output.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause and Solution</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Some pages come out all white (nothing is printed), and I am using CUPS.</td>
<td>If the data being sent is in Encapsulated PostScript (EPS) format, some earlier versions of CUPS (1.1.10 and before) have a bug preventing them from being processed correctly. When going through LLPR to print, the Printer Package will work around this issue by converting the data to regular PostScript. However, if your application bypasses LLPR and feeds EPS data to CUPS, the document may not print correctly.</td>
</tr>
<tr>
<td>I can’t print to an SMB (Windows) printer.</td>
<td>To be able to configure and use SMB-shared printers (such as printers shared on a Windows printer), you need to have a correct installation of the SAMBA package that enables that feature. The “smbclient” command should be available and usable on your system.</td>
</tr>
<tr>
<td>My application seems to be frozen while LLPR is running.</td>
<td>Most Unix applications will expect a command like the regular “lpr” command to be non-interactive and thus return immediately. Since LLPR is waiting for user input before passing the job on to the print spooler, very often the application will wait for the process to return, and thus will appear to be frozen (its windows won’t refresh). This is normal and the application should resume functioning correctly after the user exits LLPR.</td>
</tr>
<tr>
<td>How do I specify the IP address of my SMB server?</td>
<td>It can be specified in the “Add Printer” dialogue of the configuration tool, if you don’t use the CUPS printing system. Unfortunately, CUPS currently doesn’t allow you to specify the IP address of SMB printers, so you will have to be able to browse the resource with SAMBA in order to be able to print.</td>
</tr>
<tr>
<td>Some documents come out as white pages when printing.</td>
<td>Some versions of CUPS, especially those shipped with Mandrake Linux before the 8.1 release, have some known bugs when processing PostScript output from some applications. Try upgrading to the latest version of CUPS (at least 1.1.14). Some RPM packages for the most popular distributions are provided as a convenience with this Linux Printing Package.</td>
</tr>
<tr>
<td>I have CUPS and some options (such as N-up) seem to be always enabled even though I don’t choose them in LLPR.</td>
<td>There may be some local options defined in your ~/ .lpoptions file, which are manipulated by the lpoptions command. These options are always used if not overridden by LLPR settings. To get rid of all options for a printer, run the following command, replacing “printer” with the name of the queue: lpoptions -x printer</td>
</tr>
<tr>
<td>I configured a printer to print to a file, but I get “Permission denied” errors.</td>
<td>Most printing systems will not run as the super-user but as a special user (usually “lp”). Therefore, make sure that the file you have chosen to print to is accessible to the user owning the spooler daemon.</td>
</tr>
<tr>
<td>On my PCL (or GDI) printer, I sometimes get error messages printing instead of my document.</td>
<td>Unfortunately, some Unix applications may generate non-compliant PostScript output that may not be supported by Ghostscript, or even the printer itself in PostScript mode. You can try to capture the output to a file and view the results with Ghostscript (gv or ghostview will allow you to do so interactively) and see if you get error messages. However, since the application is probably at fault, contact your software vendor to inform them of the issue.</td>
</tr>
<tr>
<td>Some colour images come out all black.</td>
<td>This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base colour space of the document is indexed colour space and it is converted through CIE colour space. Because Postscript uses CIE colour space for Colour Matching System, you should upgrade Ghostscript on your system to at least GNU Ghostscript version 7.06 or later. You can find recent Ghostscript versions at <a href="http://www.ghostscript.com">www.ghostscript.com</a>.</td>
</tr>
<tr>
<td>The machine does not print.</td>
<td>The CUPS (Common Unix Printing System) version distributed with SuSE Linux 9.2 (cups-1.1.21) has a problem with ipp (Internet Printing Protocol) printing. Use the socket printing instead of ipp or install later version of CUPS (cups-1.1.22 or higher).</td>
</tr>
<tr>
<td>Some color images come out in unexpected color.</td>
<td>This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base colour space of the document is indexed RGB colour space and it is converted through CIE colour space. Because Postscript uses CIE colour space for Colour Matching System, you should upgrade Ghostscript on your system to at least GNU Ghostscript version 8.xx or later. You can find recent Ghostscript versions at <a href="http://www.ghostscript.com">www.ghostscript.com</a>.</td>
</tr>
<tr>
<td>The printer does not print PDF file correctly. Some parts of graphics, text, or illustrations are missing.</td>
<td>Incompatibility between the PDF file and the Acrobat products: Printing the PDF file as an image may solve this problem. Turn on <strong>Print As Image</strong> from the Acrobat printing options. <strong>NOTE:</strong> It will take longer to print when you print a PDF file as an image.</td>
</tr>
</tbody>
</table>
Using Your Printer on a Network

If you work in a networked environment, the printer can be shared by other users on the network.

This chapter includes:
• About Sharing the Printer on a Network
• Setting Up a Network-Connected Printer (Phaser 6110N only)

Note: If you are a Phaser 6110N user, you can only connect your printer to a network locally, for use via a single computer.

About Sharing the Printer on a Network

If you work in a networked environment, you can connect your printer to the network.

Locally-Shared Printer
You can connect the printer directly to a selected computer, which is called the “host computer” on the network. The printer can then be shared by other users on the network through a Windows 98/Me/XP/NT 4.0/2000/2003 network printer connection.

For details about sharing the printer locally, see the Software Section.

Wired Network-connected Printer (Phaser 6110N only)
The Phaser 6110N printer has a built-in network interface. For more information about connecting your printer to a network, see 2.6.

Printing Across a Network
Whether the printer is locally connected or network-connected, you need to install the Phaser 6110N series printer software on each computer that prints documents using the printer.

Setting Up a Network-Connected Printer (Phaser 6110N only)
You have to set up the network protocols on the printer to use it as your network printer. Setting protocols can be accomplished by using the SetIP program.

Supported Operating Systems

Note: The operating systems supported by the network card may be different than the operating systems supported by the printer. The following table shows the network environments supported by the printer.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Interface</td>
<td>Ethernet 10/100 Base-TX (standard)</td>
</tr>
<tr>
<td>Network Operating System</td>
<td>• Windows 98/Me/NT 4.0/2000/2003/XP</td>
</tr>
<tr>
<td></td>
<td>• Various Linux OS</td>
</tr>
<tr>
<td></td>
<td>• Macintosh OS 10.3 ~ 10.4</td>
</tr>
<tr>
<td>Network Protocols</td>
<td>• TCP/IP on Windows</td>
</tr>
<tr>
<td></td>
<td>• IPP, SNMP</td>
</tr>
<tr>
<td>Dynamic Addressing Server</td>
<td>DHCP, BOOTP</td>
</tr>
</tbody>
</table>

• TCP/IP: Transmission Control Protocol/Internet Protocol
• DHCP: Dynamic Host Configuration Protocol
• BOOTP: Bootstrap Protocol
8 Specifications

This chapter includes:

- **Printer Specifications**
- **Paper Specifications**

## Printer Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications and Description</th>
</tr>
</thead>
</table>
| Print speed*       | Black and white: Up to 16 PPM in A4 (17 PPM in Letter)  
                      Colour: Up to 4 PPM in A4(Letter)                                                                 |
| Resolution         | Up to 2400 x 600 dpi effective output                                                                 |
| First print out time | From ready  
                      Black and white: Less than 14 seconds  
                      Colour: Less than 26 seconds  
                      From coldboot  
                      Black and white: Less than 45 seconds  
                      Colour: Less than 57 seconds                                                |
| Warm-up time       | Less than 35 seconds                                                                                     |
| Power rating       | 110 ~ 127 VAC, 5 A, 50/60 Hz  
                      220 ~ 240 VAC, 3 A, 50/60 Hz                                                                 |
| Power consumption  | Average: 300 W                                                                                         |
|                    | Power save mode: Less than 17 W                                                                        |
| Noise level**      | Printing mode  
                      Black and white: Less than 49 dBA  
                      Colour: Less than 48 dBA  
                      Standby mode: Less than 35 dBA                                                     |
| Consumables life   | • Black Toner Cartridge:  
                      Approx. 2,000 A4/Letter pages at 5% Coverage  
                      (Shipped with 1,500 pages Starter toner cartridge)  
                      • Yellow/Magenta/Cyan Toner Cartridge:  
                      Approx. 1,000 A4/Letter pages at 5% Coverage  
                      (Shipped with 700 pages Starter toner cartridge)  
                      Waste toner container: Approx. 1,250 pages (full colour 5% image) or 5,000 images  
                      Imaging unit: Approx. 20,000 black or 50,000 images ** |
| Duty cycle         | Monthly: Up to 24,200 images                                                                            |
| Weight             | 13.6 kg (including consumables) (30 lbs)                                                                  |
| Package weight     | Paper: 2.4 Kg(5.29 lbs), Plastic: 380 g(0.84 lb)                                                       |
| External dimensions (W x D x H) | 390 x 344 x 265 mm (15.4 x 13.5 x 10.4 in)                                      |

* Print speed will be affected by operating system used, computing performance, application software, connecting method, media type, media size, and job complexity.

** Sound Pressure Level, ISO7779

*** May be affected by operating environment, printing interval, media type, and media size.

**** Please visit www.Xerox.com to download the latest software version.

---

## Paper Specifications

### Overview

Your printer accepts a variety of print materials, such as cut-sheet paper (including up to 100% recycled fiber content paper), envelopes, labels, and custom-size paper. Properties, such as weight, composition, grain, and moisture content, are important factors affecting the printer’s performance and the output quality. Paper that does not meet the guidelines outlined in this User’s Guide can cause the following problems:

- Poor print quality
- Increased paper jams
- Premature wear on the printer.

**NOTES:**

- Some paper may meet all of the guidelines in this guide and still not produce satisfactory results. This may be the result of improper handling, unacceptable temperature and humidity levels, or other variables over which Xerox has no control.
- Before purchasing large quantities of paper, ensure that the paper meets the requirements specified in this User’s Guide.

**CAUTION:** Using paper that does not meet these specifications may cause problems, requiring repairs. These repairs are not covered by the Xerox warranty or service agreements.
**Supported Sizes of Paper**

<table>
<thead>
<tr>
<th>Tray* (mm/in)</th>
<th>Paper tray</th>
<th>Weight</th>
<th>Capacity**</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Tray</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>Letter (216 x 279/8.5 x 11)</td>
<td>Manual feed mode</td>
<td>60 to 105 g/m² (16 to 23 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>A4 (210 x 297/8.27 x 11.69)</td>
<td>Manual feed mode</td>
<td>75 to 90 g/m² (20 to 24 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>A5 (148 x 210/5.83 x 8.27)</td>
<td>Manual feed mode</td>
<td>120 to 150 g/m² (32 to 40 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Executive (184 x 267/7.25 x 10.5)</td>
<td>Manual feed mode</td>
<td>105 to 163 g/m² (23 to 44 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Legal (216 x 356/8.5 x 14)</td>
<td>Manual feed mode</td>
<td>60 to 120 g/m² (16 to 32 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>JIS B5 (182 x 257/7.17 x 10.12)</td>
<td>Manual feed mode</td>
<td>138 to 146 g/m² (37 to 39 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>A6 (105 x 148/4.13 x 5.83)</td>
<td>Manual feed mode</td>
<td>60 to 105 g/m² (16 to 23 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Oficio (216 x 343/8.5 x 13.5)</td>
<td>Manual feed mode</td>
<td>75 to 90 g/m² (20 to 24 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Folio (216 x 330/8.5 x 13)</td>
<td>Manual feed mode</td>
<td>105 to 163 g/m² (23 to 44 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Envelopes No.10 (105 x 241/4.13 x 9.49)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>DL (110 x 220/4.33 x 8.66)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>C5 (162 x 229/6.38 x 9.02)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>C6 (142 x 162/4.49 x 6.38)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>Monarch (98 x 191/3.87 x 7.50)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>No.9 (98 x 225/3.87 x 8.87)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>6 3/4 Envelop (92 x 165/3.62 x 6.5)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>150 sheets of 75 g/m² (20 lb) bond paper</td>
</tr>
<tr>
<td>Labels***</td>
<td>Manual feed mode</td>
<td>120 to 150 g/m² (32 to 40 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Letter (216 x 279/8.5 x 11)</td>
<td>Manual feed mode</td>
<td>120 to 150 g/m² (32 to 40 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>A4 (210 x 297/8.3 x 11.7)</td>
<td>Manual feed mode</td>
<td>120 to 150 g/m² (32 to 40 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Transparency films</td>
<td>Manual feed mode</td>
<td>138 to 146 g/m² (37 to 39 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Letter (216 x 279/8.5 x 11)</td>
<td>Manual feed mode</td>
<td>138 to 146 g/m³ (37 to 39 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>A4 (210 x 297/8.3 x 11.7)</td>
<td>Manual feed mode</td>
<td>138 to 146 g/m³ (37 to 39 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Card stocks Post Card (101.6 x 152.4/4 x 6)</td>
<td>Manual feed mode</td>
<td>105 to 163 g/m² (23 to 44 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Minimum size (custom, 76 x 127/3 x 5)</td>
<td>Manual feed mode</td>
<td>60 to 120 g/m² (16 to 32 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
<tr>
<td>Maximum size (Legal)</td>
<td>Manual feed mode</td>
<td>60 to 90 g/m² (16 to 24 lb) bond</td>
<td>1 sheet of paper</td>
</tr>
</tbody>
</table>

* The printer supports a wide range of media sizes.

** Capacity may vary depending on print material’s weight and thickness, and environmental conditions.

*** Smoothness: 100 to 250 (Sheffield)

---

**Guidelines for Using Paper**

For the best result, use conventional 75 g/m² (20 lb) paper. Ensure that the paper is of good quality, and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, and curled or bent edges.

If you are unsure of what type of paper you are loading, such as bond or recycled paper, check the label on the package.

The following problems may cause print quality deviations, jamming or even damage to the printer.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Problem with Paper</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poor print quality or toner adhesion, problems with feeding</td>
<td>Too moist, too rough, too smooth, or embossed; faulty paper lot</td>
<td>Try another kind of paper, between 100 ~ 250 Sheffield, 4 ~ 5 % moisture content.</td>
</tr>
<tr>
<td>Dropout, jamming, curl</td>
<td>Stored improperly</td>
<td>Store paper flat in its moisture-proof wrapping.</td>
</tr>
<tr>
<td>Increased gray background shading/printer wear</td>
<td>Too heavy</td>
<td>Use lighter paper.</td>
</tr>
<tr>
<td>Excessive curl problems with feeding</td>
<td>Too moist, wrong grain direction, or short-grain construction</td>
<td>Use long-grain paper.</td>
</tr>
<tr>
<td>Jamming, damage to printer</td>
<td>Cutouts or perforations</td>
<td>Do not use paper with cutouts or perforations.</td>
</tr>
<tr>
<td>Problems with feeding</td>
<td>Ragged edges</td>
<td>Use good quality paper.</td>
</tr>
</tbody>
</table>

**NOTES:**
- Do not use letterhead paper printed with low-temperature inks, such as those used in some types of thermography.
- Do not use raised or embossed letterhead.
- The printer uses heat and pressure to fuse toner to the paper. Ensure that any coloured paper or preprinted forms use inks that are compatible with this fusing temperature (180 °C or 356 °F for 0.1 second).
Paper Specifications

<table>
<thead>
<tr>
<th>Category</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acid Content</td>
<td>5.5 ~ 8.0 pH</td>
</tr>
<tr>
<td>Caliper</td>
<td>0.094 ~ 0.18 mm (3.0 ~ 7.0 mils)</td>
</tr>
<tr>
<td>Curl in Ream</td>
<td>Flat within 5 mm (0.02 in)</td>
</tr>
<tr>
<td>Cut Edge Conditions</td>
<td>Cut with sharp blades with no visible fray.</td>
</tr>
<tr>
<td>Fusing Compatibility</td>
<td>Must not scorch, melt, offset, or release hazardous emissions when heated to 180 °C (356 °F) for 0.1 second.</td>
</tr>
<tr>
<td>Grain</td>
<td>Long Grain</td>
</tr>
<tr>
<td>Moisture Content</td>
<td>4 % ~ 6 % by weight</td>
</tr>
<tr>
<td>Smoothness</td>
<td>100 ~ 250 Sheffield</td>
</tr>
</tbody>
</table>

Paper Output Capacity

<table>
<thead>
<tr>
<th>Output Tray</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-down</td>
<td>100 sheets of 75 g/m² paper</td>
</tr>
</tbody>
</table>

Paper Input Capacity

<table>
<thead>
<tr>
<th>Input Tray</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray</td>
<td>150 sheets of 75 g/m² paper</td>
</tr>
<tr>
<td>Manual feed mode</td>
<td>1 sheet of 60~163 g/m² paper</td>
</tr>
</tbody>
</table>

Printer and Paper Storage Environment

Paper storage environmental conditions directly affect the feed operation.

Ideally, the printer and paper storage environment should be at or near room temperature, and not too dry or humid. Remember that paper is hygroscopic; it absorbs and loses moisture rapidly.

Heat works with humidity to damage paper. Heat causes the moisture in paper to evaporate, while cold causes it to condense on the sheets. Heating systems and air conditioners remove most of the humidity from a room. As paper is opened and used, it loses moisture, causing streaks and smudging. Humid weather or water coolers can cause the humidity to increase in a room. As paper is opened and used it absorbs any excess moisture, causing light print and dropouts. Also, as paper loses and gains moisture it can become distorted. This can cause paper jams.

Care should be taken not to purchase more paper than can be used in a short time (about 3 months). Paper stored for long periods may experience heat and moisture extremes, which can cause damage. Planning is important to prevent damage to large supplies of paper.

Unopened paper in sealed reams can remain stable for several months before use. Opened packages of paper have more potential for environmental damage, especially if they are not wrapped with a moisture-proof barrier.

The paper storage environment should be properly maintained to ensure optimum printer performance. The required condition is 20 to 24 °C (68 to 75 °F), with a relative humidity of 45 % to 55 %. The following guidelines should be considered when evaluating the paper’s storage environment:

- Paper should be stored at or near room temperature.
- The air should not be too dry or too humid.
- The best way to store an opened ream of paper is to rewrap it tightly in its moisture-proof wrapping. If the printer environment is subject to extremes, unwrap only the amount of paper to be used during the day’s operation to prevent unwanted moisture changes.

Envelopes

Envelope construction is critical. Envelope fold lines can vary considerably, not only between manufacturers, but also within a box from the same manufacturer. Successful printing on envelopes depends upon the quality of the envelopes. When selecting envelopes, consider the following factors:

- Weight: The weight of the envelope paper should not exceed 90 g/m² (24 lb) or jamming may occur.
- Construction: Prior to printing, envelopes should lie flat with less than 6 mm (0.25 in) curl, and should not contain air.
Specifications

8.4

- Condition: Envelopes should not be wrinkled, nicked, or otherwise damaged.
- Temperature: You should use envelopes that are compatible with the heat and pressure of the printer.
- Size: You should only use envelopes within the following size ranges.

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray</td>
<td>3 x 5 in</td>
<td>8.5 x 14 in</td>
</tr>
<tr>
<td></td>
<td>(76 x 127 mm)</td>
<td>(216 x 356 mm)</td>
</tr>
</tbody>
</table>

**NOTE:** You may experience some paper jams when using any media with a length less than 127 mm (5 in). This may be caused by paper that has been affected by environmental conditions. For optimum performance, make sure you are storing and handling the paper correctly. Please refer to “Printer and Paper Storage Environment” on page 8.3.

### Envelopes with Double Side Seams

Double side-seam construction has vertical seams at both ends of the envelope rather than diagonal seams. This style may be more likely to wrinkle. Be sure the seam extends all the way to the corner of the envelope as illustrated below.

![Correct](image)

![Incorrect](image)

### Envelopes with Adhesive Strips or Flaps

Envelopes with a peel-off adhesive strip or with more than one flap that folds over to seal must use adhesives compatible with the heat and pressure in the printer. The extra flaps and strips might cause wrinkling, creasing, or even jams, and may even damage the fuser.

### Envelope Margins

The following gives typical address margins for a commercial #10 or DL envelope.

<table>
<thead>
<tr>
<th>Type of Address</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return address</td>
<td>0.6 in</td>
<td>2 in</td>
</tr>
<tr>
<td></td>
<td>(15 mm)</td>
<td>(51 mm)</td>
</tr>
<tr>
<td>Delivery address</td>
<td>2 in</td>
<td>3.5 in</td>
</tr>
<tr>
<td></td>
<td>(51 mm)</td>
<td>(90 mm)</td>
</tr>
</tbody>
</table>

**NOTES:**
- For best print quality, position margins no closer than 0.6 in (15 mm) from the edges of the envelope.
- Avoid printing over the area where the envelope’s seams meet.

### Envelope Storage

Proper storage of envelopes helps contribute to print quality. Envelopes should be stored flat. If air is trapped in an envelope, creating an air bubble, then the envelope may wrinkle during printing. See “Printing on Envelopes” on page 3.3.

### Labels

**CAUTION:**
- To avoid damaging the printer, use only labels recommended for laser printers.
- Never print on the same sheet of labels more than once and never print on a partial sheet of labels.

When selecting labels, consider the quality of each component:
- Adhesives: The adhesive material should be stable at 180 °C (356 °F), the printer’s fusing temperature.
- Arrangement: Only use labels with no exposed backing between them. Labels can peel off sheets with spaces between the labels, causing serious jams.
- Curl: Prior to printing, labels must lie flat with no more than 0.5 in (13 mm) of curl in any direction.
- Condition: Do not use labels with wrinkles, bubbles, or other indications of separation.

See “Printing on Labels” on page 3.3.

### Transparencies

Transparencies used in the machine must be able to withstand 180 °C (356 °F), the machine’s fusing temperature.

**CAUTION:** To avoid damaging the machine, use only transparencies recommended for use in laser printers.
INDEX

C
card stock, print 3.5
cleaning
   inside 5.7
   outside 5.7
components 1.2
configuration page, print 5.1
connecting
   network 2.6
   USB 2.6
custom-sized materials, print 3.5

D
demo page, print 2.7

E
envelopes, print 3.3
ethernet cable, connect 2.6

F
features 1.1

I
imaging unit
   life 8.1
   replace 5.4

L
labels, print 3.3
LEDs status 1.3
Linux
   common problems 6.9
   driver, install 2.7

M
Macintosh
   common problems 6.8
   driver, install 2.7
manual feed, use 3.2

N
network printing
   cable, connect 2.6
   network-connected printer, set 7.1

P
paper
   choose 3.1
   guideline 3.1
   loading 3.2
   sizes and capacities 3.1
   specifications 8.1
paper jams, clear 6.3
paper load capacity 3.1
paper size, change in the tray 2.5
paper, load 2.3
preprinted paper, print 3.4
print quality problems, solve 6.5
printer driver, install 2.7
printing
   configuration page 5.1
   demo page 2.7
problem, solve
   checklist 6.1
   general 6.2
   Linux 6.9
   Macintosh 6.8
   paper jams 6.3
   print quality 6.5
   Windows 6.8

Q
quality problems, solve 6.5

R
replacing
   imaging unit 5.4
   toner cartridge 5.3
   waste toner container 5.6

S
specification
   paper 8.3
   printer 8.1

T
toner cartridge
   maintaining 5.2
   redistributing 5.2
   replacing 5.3
   transparency, print 3.4

U
USB, connect 2.6

W
waste toner container
   life 8.1
   replace 5.6
Software section

Section Logiciel

Softwaredokumentation

Sezione software

Sección de software

Manual do Usuário do Software

Software

Программное обеспечение

Sekcja Oprogramowanie

Szoftverszakasz

Sekce softwaru

Yazılım bölümü

Softwareafsnit

Ohjelmisto

Om programvaren

Ενότητα λογισμικού

Om programvara
# Contents

**Chapter 1: Installing Printer Software in Windows**

- Installing Software ........................................................................................................... 3
- Removing Software ............................................................................................................. 3

**Chapter 2: Using SetIP**

**Chapter 3: Basic Printing**

- Printing a Document ........................................................................................................... 5
- Printer Settings .................................................................................................................. 6
  - Layout Tab .................................................................................................................... 6
  - Paper Tab ..................................................................................................................... 7
  - Graphics Tab ................................................................................................................. 8
  - Other Features Tab ........................................................................................................ 9
- Using a Favorite Setting .................................................................................................... 9
- Using Help ....................................................................................................................... 9

**Chapter 4: Advanced Printing**

- Printing Multiple Pages on One Sheet of Paper (N-Up Printing) ..................................................... 10
- Printing Posters ................................................................................................................ 11
- Printing Booklets ............................................................................................................. 11
- Printing on Both Sides of Paper ....................................................................................... 12
- Printing a Reduced or Enlarged Document ....................................................................... 12
- Fitting Your Document to a Selected Paper Size .................................................................. 12
- Using Watermarks ........................................................................................................... 13
  - Using an Existing Watermark ...................................................................................... 13
  - Creating a Watermark .................................................................................................. 13
  - Editing a Watermark ..................................................................................................... 13
  - Deleting a Watermark ................................................................................................. 13
Chapter 5: SHARING THE PRINTER LOCALLY

Setting Up a Host Computer ................................................................. 15
Setting Up a Client Computer ............................................................. 15

Chapter 6: USING UTILITY APPLICATIONS

Using Printer Settings Utility .............................................................. 16
  Using Onscreen Help ........................................................................ 16
Opening the Troubleshooting Guide .................................................. 16
Changing the Status Monitor Program Settings .................................. 16

Chapter 7: USING YOUR PRINTER IN LINUX

System Requirements .......................................................................... 17
Installing the Printer Driver ............................................................... 18
  Changing the Printer Connection Method ...................................... 19
  Uninstalling the Printer Driver ........................................................ 20
Using the Configuration Tool ............................................................. 20
Changing LLPR Properties ................................................................. 21

Chapter 8: USING YOUR PRINTER WITH A MACINTOSH

Installing Software for Macintosh ...................................................... 22
Setting Up the Printer ........................................................................ 23
  For a Network-connected Macintosh .............................................. 23
  For a USB-connected Macintosh .................................................... 23
Printing ............................................................................................. 24
  Printing a Document ...................................................................... 24
Changing Printer Settings ................................................................. 24
Printing Multiple Pages on One Sheet of Paper .............................. 25
Installing Printer Software in Windows

Installing Software

All applications should be closed on your PC before beginning installation.

**NOTE:** If the “New Hardware Wizard” window appears during the installation procedure, click  in the upper right corner of the box to close the window, or click Cancel.

1. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run and an installation window appears.

2. Choose the type of installation.

3. Follow the instructions on the screen to complete the installation.

**NOTE:** If the installation window does not appear, click Start and then Run. Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive and click OK.

Removing Software

1. Start Windows.

2. From the Start menu select Programs or All Programs → Xerox Phaser 6110 → Maintenance

3. You will see a component list so that you can remove any item individually.

4. When your computer asks you to confirm your selection, click Yes or OK. The selected driver and all of its components are removed from your computer.

5. After the software is removed, click OK or Finish.
Using SetIP

**NOTE:** To install Set IP, select **Install SetIP Utility** on installation window appears. For details, see “Installing Software” on page 3.

1. From the Windows Start menu, select **Programs** or **All Programs** → **Xerox Phaser 6110** → **SetIP** → **SetIP**.

The program automatically detects and displays new and configured print servers on your network.

2. Select the name of your printer and click **. If you cannot find your printer name, click ** to refresh the list.

**NOTE:** The refreshed list doesn’t show your printer, click ** and enter your network printer card’s IP address, subnet mask, default gateway, and then click **.

3. Click **OK** to confirm the settings.

4. Click **Exit** to close the SetIP program.
This chapter explains the printing options and common printing tasks in Windows.

This chapter includes:
- Printing a Document
- Printer Settings
  - Layout Tab
  - Paper Tab
  - Graphics Tab
  - Other Features Tab
- Using a Favorite Setting
- Using Help

### Printing a Document

**NOTES:**
- Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use. However the composition of the printer properties window is similar.
- Check the Operating System(s) that are compatible with your printer. Please refer to the OS Compatibility section of Printer Specifications in your Printer User’s Guide.
- If you need to know the exact name of your printer, you can check the supplied Printer software CD.

The following procedure describes the general steps required for printing from various Windows applications. The exact steps for printing a document may vary depending on the application program you are using. Refer to the User’s Guide of your software application for the exact printing procedure.

1. Open the document you want to print.
2. Select **Print** from the **File** menu. The Print window is displayed. It may look slightly different depending on your application.
   The basic print settings are selected within the Print window. These settings include the number of copies and print range.

![Image of Print window]

   Make sure that your printer is selected.

3. Select your printer driver from the **Name** drop-down list.
4. To take advantage of the printer features provided by your printer driver, click **Properties** or **Preferences** in the application’s Print window. For details, see “Printer Settings” on page 6.
   If you see **Setup**, **Printer**, or **Options** in your Print window, click it instead. Then click **Properties** on the next screen.
5. Click **OK** to close the printer properties window.
6. To start the print job, click **OK** or **Print** in the Print window.
**Printer Settings**

You can use the printer properties window, which allows you to access all of the printer options you need when using your printer. When the printer properties are displayed, you can review and change the settings needed for your print job.

Your printer properties window may differ, depending on your operating system. This Software section shows the Properties window for Windows XP.

Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use.

**NOTES:**

- Most Windows applications will override settings you specify in the printer driver. Change all print settings available in the software application first, and change any remaining settings using the printer driver.
- The settings you change remain in effect only while you are using the current program. To make your changes permanent, make them in the Printers folder.
- The following procedure is for Windows XP. For other Windows OS, refer to the corresponding Windows User’s Guide or online help.
  1. Click the Windows **Start** button.
  2. Select **Printers and Faxes**.
  3. Select your printer driver icon.
  4. Right-click on the printer driver icon and select **Printing Preferences**.
  5. Change the settings on each tab, click OK.

---

**Layout Tab**

The **Layout** tab provides options to adjust how the document appears on the printed page. The **Layout Options** includes **Multiple Pages per Side** and **Poster**. See “Printing a Document” on page 5 for more information on accessing printer properties.

**Orientation**

**Orientation** allows you to select the direction in which information is printed on a page.
- **Portrait** prints across the width of the page, letter style.
- **Landscape** prints across the length of the page, spreadsheet style.

- **Rotate 180 Degrees** allows you to rotate the page, 180 degrees.

**Layout Options**

**Layout Options** allows you to select advanced printing options. You can choose **Multiple Pages per Side**, **Poster** and **Booklet**.
- For details, see “Printing Multiple Pages on One Sheet of Paper (N-Up Printing)” on page 10.
- For details, see “Printing Posters” on page 11.
- For details, see “Printing Booklets” on page 11.

**Double-sided Printing**

**Double-sided Printing** allows you to print on both sides of paper.
- For details, see “Printing on Both Sides of Paper” on page 12.
Paper Tab
Use the following options to set the basic paper handling specifications when you access the printer properties. See “Printing a Document” on page 5 for more information on accessing printer properties.
Click the Paper tab to access various paper properties.

1 Copies
Copies allows you to choose the number of copies to be printed. You can select 1 to 999 copies.

2 Size
Size allows you to set the size of paper you loaded in the tray. If the required size is not listed in the Size box, click Custom. When the Custom Page Size window appears, set the paper size and click OK. The setting appears in the list so that you can select it.

3 Source
Make sure that Source is set to the corresponding paper tray. Use Manual Feed when printing on special materials like envelopes and transparencies. You have to load one sheet at a time into the Manual Tray.

4 Type
Set Type to correspond to the paper loaded in the tray from which you want to print. This will let you get the best quality printout. If not, print quality may not be acheived as you want.
Cotton: 20 lb to 24 lb (75~90 g/m²) cotton paper such as Gilbert 25 % and Gilbert 100 %.
Plain Paper: Normal plain paper. Select this type if your printer is monochrome and printing on the 16 lb (60 g/m²) cotton paper.
Recycled: 20 lb to 24 lb (75~90 g/m²) recycled paper.
Colour Paper: 20 lb to 24 lb (75~90 g/m²) colour-backgrounded paper.

5 Scaling
Scaling allows you to automatically or manually scale your print job on a page. You can choose from None, Reduce/Enlarge, and Fit to Page.
- For details, see "Printing a Reduced or Enlarged Document" on page 12.
- For details, see "Fitting Your Document to a Selected Paper Size" on page 12.
Graphics Tab

Use the following Graphic options to adjust the print quality for your specific printing needs. See "Printing a Document" on page 5 for more information on accessing printer properties. Click the Graphics tab to display the properties shown below.

Quality

The Resolution options you can select may vary depending on your printer model. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

Colour Mode

You can choose colour options. Setting to Colour typically produces the best possible print quality for colour documents. If you want to print a colour document in black and white document, select Black & White. If you want to adjust the colour options manually, select Manual and click the Colour Adjust or Colour Matching button.

• Colour Adjust: You can adjust the appearance of images by changing the settings in the Levels option.
• Colour Matching: You can adjust the appearance of images by changing the settings in the Settings option.

Advanced Options

You can set advanced settings by clicking the Advanced Options button.

• TrueType Options: This option determines what the driver tells the printer about how to image the text in your document. Select the appropriate setting according to the status of your document. This option may be available only in Windows 9x/Me, depending on your particular printer model.

  - Download as Bit Image: When this option is selected, the driver will download the font data as bitmap images. Documents with complicated fonts, such as Korean or Chinese, or various other fonts, will print faster in this setting.

  - Print as Graphics: When this option is selected, the driver will download any fonts as graphics. When printing documents with high graphic content and relatively few TrueType fonts, printing performance (speed) may be enhanced in this setting.

• Print All Text Black: When the Print All Text Black option is checked, all text in your document prints solid black, regardless of the colour it appears on the screen.

• Darken Text: When the Darken Text option is checked, all text in your document is allowed to print darker than on a normal document.
Other Features Tab

You can select output options for your document. See “Printing a Document” on page 5 for more information about accessing the printer properties.

Click the Other Features tab to access the following feature:

1 Watermark
You can create a background text image to be printed on each page of your document. For details, see “Using Watermarks” on page 13.

2 Overlay
Overlays are often used to take the place of preprinted forms and letterhead paper. For details, see “Using Overlays” on page 14.

NOTE: The Overlay feature is not supported in NT 4.0.

3 Output Options
- **Print Order**: You can set the sequence in which the pages print. Select the print order from the drop-down list.
  - **Normal**: Your printer prints all pages from the first page to the last page.
  - **Reverse All Pages**: Your printer prints all pages from the last page to the first page.
  - **Print Odd Pages**: Your printer prints only the odd numbered pages of the document.
  - **Print Even Pages**: Your printer prints only the even numbered pages of the document.

Using a Favorite Setting

The **Favorites** option, which is visible on each properties tab, allows you to save the current properties settings for future use.

To save a **Favorites** item:

1 Change the settings as needed on each tab.
2 Enter a name for the item in the **Favorites** input box.
3 Click **Save**.

When you save **Favorites**, all current driver settings are saved.

To use a saved setting, select the item from the **Favorites** drop down list. The printer is now set to print according to the Favorites setting you selected.

To delete a Favorites item, select it from the list and click **Delete**.

You can also restore the printer driver’s default settings by selecting **Printer Default** from the list.

Using Help

Your printer has a help screen that can be activated by clicking the **Help** button in the printer properties window. These help screens give detailed information about the printer features provided by the printer driver.

You can also click ![Help](image) from the upper right corner of the window, and then click on any setting.
Advanced Printing

This chapter explains printing options and advanced printing tasks.

NOTE:
- Your printer driver Properties window that appears in this User's Guide may differ depending on the printer in use. However, the composition of the printer properties window is similar.
- If you need to know the exact name of your printer, you can check the supplied Printer software CD.

This chapter includes:
- Printing Multiple Pages on One Sheet of Paper (N-Up Printing)
- Printing Posters
- Printing Booklets
- Printing on Both Sides of Paper
- Printing a Reduced or Enlarged Document
- Fitting Your Document to a Selected Paper Size
- Using Watermarks
- Using Overlays

**Printing Multiple Pages on One Sheet of Paper (N-Up Printing)**

You can select the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and arranged in the order you specify. You can print up to 16 pages on one sheet.

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. From the Layout tab, choose Multiple Pages per Side in the Type drop-down list.
3. Select the number of pages you want to print per sheet (1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down list.
4. Select the page order from the Page Order drop-down list.
   Check Print Page Border to print a border around each page on the sheet.
5. Click the Paper tab, select the paper source, size, and type.
6. Click OK and print the document.
**Printing Posters**

This feature allows you to print a single-page document onto 4, 9, or 16 sheets of paper, for the purpose of pasting the sheets together to form one poster-size document.

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. Click the **Layout** tab, select **Poster** in the **Type** drop-down list.
3. Configure the poster option:
   - You can select the page layout from **2x2**, **3x3**, or **4x4**. If you select **2x2**, the output will be automatically stretched to cover 4 physical pages.
   - Specify an overlap in millimeters or inches to make it easier to pasting the sheets together.
4. Click the **Paper** tab, select the paper source, size, and type.
5. Click **OK** and print the document. You can complete the poster by pasting the sheets together.

**Printing Booklets**

This printer feature allows you to print your document on both sides of the paper and arranges the pages so that the paper can be folded in half after printing to produce a booklet.

1. To change the print settings from your software application, access the printer properties. See “Printing a Document” on page 5.
2. From the **Layout** tab, choose **Booklet Printing** from the **Type** drop-down list.
3. **Note**: The booklet printing option is available when A4, Letter, Legal, or Folio size is selected in the **Size** option on the **Paper** tab.
4. Click the **Paper** tab, and select the paper source, size, and type.
5. Click **OK** and print the document.
6. After printing, fold and staple the pages.
Printing on Both Sides of Paper

You can print on both sides of a sheet of paper. Before printing, decide how you want your document oriented.

The options are:

- **None**
- **Long Edge**, which is the conventional layout used in book binding.
- **Short Edge**, which is the type often used with calendars.

![Long Edge](image1) ![Short Edge](image2)

**NOTE:**
- Do not print on both sides of labels, transparencies, envelopes, or thick paper. Paper jamming and damage to the printer may result.
- To use double-sided printing, you can use only the following paper sizes: A4, Letter, Legal, and Folio, with a weight of 20~24 lbs (75~90 g/m²).

1. To change the print settings from your software application, access printer properties. “Printing a Document” on page 5.
2. From the **Layout** tab, select the paper orientation.
3. From the **Double-sided Printing[Manual]** section, select the binding option you want.
4. Click the **Paper** tab and select the paper source, size, and type.
5. Click **OK** and print the document.

**NOTE:** If your printer does not have a duplex unit, you should complete the printing job manually. The printer prints every other page of the document first. After printing the first side of your job, the Printing Tip window appears. Follow the on-screen instructions to complete the printing job.

Printing a Reduced or Enlarged Document

You can change the size of a page’s content to appear larger or smaller on the printed page.

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. From the **Paper** tab, select **Reduce/Enlarge** in the **Type** drop-down list.
3. Enter the scaling rate in the **Percentage** input box. You can also click the ▼ or ▲ button.
4. Select the paper source, size, and type in **Paper Options**.
5. Click **OK** and print the document.

Fitting Your Document to a Selected Paper Size

This printer feature allows you to scale your print job to any selected paper size regardless of the digital document size. This can be useful when you want to check fine details on a small document.

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. From the **Paper** tab, select **Fit to Page** in the **Type** drop-down list.
3. Select the correct size from the **Target Page** drop-down list.
4. Select the paper source, size, and type in **Paper Options**.
5. Click **OK** and print the document.
Using Watermarks

The Watermark option allows you to print text over an existing document. For example, you may want to have large gray letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document.

There are several predefined watermarks that come with the printer, and they can be modified, or you can add new ones to the list.

Using an Existing Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. Click the Extras tab, and select the desired watermark from the Watermark drop-down list. You will see the selected watermark in the preview image.
3. Click OK and start printing.

NOTE: The preview image shows how the page will look when it is printed.

Creating a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. Click the Extras tab, and click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Enter a text message in the Watermark Message box. You can enter up to 40 characters. The message displays in the preview window.
   When the First Page Only box is checked, the watermark prints on the first page only.
4. Select watermark options.
   You can select the font name, style, size, or grayscale level from the Font Attributes section and set the angle of the watermark from the Message Angle section.
5. Click Add to add a new watermark to the list.
6. When you have finished editing, click OK and start printing.

To stop printing the watermark, select <No Watermark> from the Watermark drop-down list.

Editing a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. Click the Extras tab and click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options.
4. Click Update to save the changes.
5. Click OK until you exit the Print window.

Deleting a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
2. From the Extras tab, click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Select the watermark you want to delete from the Current Watermarks list and click Delete.
4. Click OK until you exit the Print window.
Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. Overlays are often used to take the place of preprinted forms and letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing the exact same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load preprinted letterhead paper in the printer. You need only tell the printer to print the letterhead overlay on your document.

NOTE: The Overlay feature is not supported in NT 4.0.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay containing your logo or image.

1. Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to appear when printed as an overlay.
2. To save the document as an overlay, access printer properties. See “Printing a Document” on page 5.
3. Click the Extras tab, and click Edit button in the Overlay section.
4. In the Edit Overlay window, click Create Overlay.
5. In the Create Overlay window, type a name in the File name box. Select the destination path, if necessary. (The default is C:\Formover).
6. Click Save. The name appears on the Overlay List box.
7. Click OK or Yes to finish creating.

The file is not printed. Instead it is stored on your computer hard disk drive.

NOTE: The overlay document size must be the same as the documents you print with the overlay. Do not create an overlay with a watermark.

Using a Page Overlay
After an overlay has been created, it is ready to be printed with your document. To print an overlay with a document:

1. Create or open the document you want to print.
2. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 5.
3. Click the Extras tab.
4. Select the desired overlay from the Overlay drop-down list box.
5. If the overlay file you want does not appear in the Overlay list, click Edit button and Load Overlay, and select the overlay file.

If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Load Overlay window.

After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay List box.

6. If necessary, click Confirm Page Overlay When Printing. If this box is checked, a message window appears each time you submit a document for printing, asking you to confirm your wish to print an overlay on your document.

If this box is not checked and an overlay has been selected, the overlay automatically prints with your document.

7. Click OK or Yes until printing begins.

The selected overlay downloads with your print job and prints on your document.

NOTE: The resolution of the overlay document must be the same as that of the document you will print with the overlay.

Deleting a Page Overlay
You can delete page overlays that you no longer use.

1. In the printer properties window, click the Extras tab.
2. Click the Edit button in the Overlay section.
3. Select the overlay you want to delete from the Overlay List box.
4. Click Delete Overlay.
5. When a confirming message window appears, click Yes.
6. Click OK until you exit the Print window.
Sharing the Printer Locally

You can connect the printer directly to a selected computer, which is called "host computer," on the network.

The following procedure is for Windows XP. For other Windows OS, refer to the corresponding Windows User's Guide or online help.

**NOTES:**
- Check the Operating System(s) that are compatible with your printer. Please refer to the OS Compatibility section of Printer Specifications in your Printer User’s Guide.
- If you need to know the exact name of your printer, you can check the supplied Printer software CD.

---

### Setting Up a Host Computer

1. Start Windows.
2. From the **Start** menu select **Printers and Faxes**.
3. Double-click your printer driver icon.
4. From the **Printer** menu, select **Sharing**.
5. Check the **Share this printer** box.
6. Fill in the **Shared Name** field, and then click **OK**.

### Setting Up a Client Computer

1. Right-click the Windows **Start** button and select **Explorer**.
2. Open your network folder in the left column.
3. Click the shared name.
4. From the **Start** menu select **Printers and Faxes**.
5. Double-click your printer driver icon.
6. From the **Printer** menu, select **Properties**.
7. From the **Ports** tab, click **Add Port**.
8. Select **Local Port** and click **New Port**.
9. Fill in the **Enter a port name** field with the shared name.
10. Click **OK** and click **Close**.
11. Click **Apply** and click **OK**.
Using Utility Applications

If an error occurs while printing, the Status Monitor window appears, showing the error.

**NOTES:**
- To use this program, you need:
  - Windows 98 or higher (Windows NT 4.0 can be used only for network-supported printers.) To check for Operating System(s) that are compatible with your printer, refer to Printer Specifications in your Printer User's Guide.
  - Internet Explorer version 5.0 or higher for flash animation in HTML Help.
- If you need to know the exact name of your printer, you can check the supplied CD-ROM.

Using Printer Settings Utility

Using the Printer Settings Utility, you can configure and check print settings.
1. From the **Start** menu, select **Programs** or **All Programs** → **Xerox Phaser 6110** → **Printer Settings Utility**.
2. Change the settings.
3. To send the changes to the printer, click the **Apply** button.

Using Onscreen Help

For more information about **Printer Settings Utility**, click 📚.

Opening the Troubleshooting Guide

Double click the Status Monitor icon on the Windows task bar.

Or, from the **Start** menu, select **Programs** or **All Programs** → **Xerox Phaser 6110** → **Troubleshooting Guide**.

Changing the Status Monitor Program Settings

Select the Status Monitor icon on the Windows task bar and right-click on the Status Monitor icon. Select **Option**. The following window opens.

- **Display when job is finished for network printer** shows the Status Monitor balloon when your job is complete.
- **Display when error occurs during printing** shows the Status Monitor balloon when an error occurs during printing.
- **Schedule an automatic status checking every** allows the computer to update the printer status regularly. Setting the value close to 1 second causes the computer to check the printer status more frequently, thereby allowing a faster response to any printer error.

**NOTE:** When the Status Monitor balloon appears to indicate an error, you can cancel the current print job or view the corresponding solution. If you select **Cancel Printing**, turn off the printer and then click **OK**. It may take several minutes. Note that data which is being sent to the printer via the network will be lost.
7 Using Your Printer in Linux

You can use your printer in a Linux environment.

This chapter includes:
- System Requirements
- Installing the Printer Driver
- Changing the Printer Connection Method
- Uninstalling the Printer Driver
- Using the Configuration Tool
- Changing LLPR Properties

System Requirements

Supported OS
- Red Hat 8.0 ~ 9.0
- Fedora Core 1, 2, 3
- Mandrake 9.2 ~ 10.1
- SuSE 8.2 ~ 9.2

Recommended Capacities
- Pentium IV 1 GHz or higher
- RAM 256 MB or higher
- HDD 1 GB or higher

Software
- Glibc 2.1 or higher
- GTK+ 1.2 or higher
- GhostScript

Notes:
- The Linux printer's properties window that appears in this User's Guide may differ depending on the printer in use. However, the composition of the properties is similar.
- You can check your printer name in the supplied Printer software CD.
Installing the Printer Driver

1. Make sure that you connect the printer to your computer. Turn both the computer and the printer on.

2. When the Administrator Login window appears, type in "root" in the Login field and enter the system password.

**NOTE:** You must log in as a super user (root) to install the printer software. If you are not a super user, ask your system administrator.

3. Insert the Printer software CD. The CD-ROM automatically runs.

**NOTE:** If the Printer software CD does not automatically run, click the icon at the bottom of the window. When the Terminal screen appears, type in:

```
[root@local /root]# mount -t iso9660 /dev/hdc /mnt/cdrom (Assuming that /dev/hdc is your CD-ROM path and you have /mnt/cdrom directory)
[root@local /root]# cd /mnt/cdrom (the CD-ROM directory)
[root@local cdrom]# ./setup.sh
```

4. Select the type of installation, either Recommended or Expert, and then click Continue.

**Recommended** is fully automated and does not require any interaction. **Expert** installation allows you to select the install path or printing system.

5. If you selected Recommended, go to step 6.

For **Expert**, select the desired option and then click **Begin Install**.

6. The printer driver installation begins. When the installation is completed, click **Start**.

7. The Linux Printer Configuration window opens. Click the **Add Printer** icon on the toolbar at the top of the window.

**NOTE:** Depending on the printing system in use, the Administrator Login window may appear. Type in "root" in the Login field and enter the system password.

8. You see the printers currently installed in your system. Select the printer you want to use. The function tabs available for the selected printer appear at the top of the Add a Printer window.

**NOTE:** If the printer supports PS printing, it is recommended to select the PS driver.
Changing the Printer Connection Method

If you change the printer connection method from USB to Network or vice versa while in use, you must reconfigure your Linux printer by adding the printer to your system. Take the following steps:

1. Make sure that you connect the printer to your computer. Turn both the computer and the printer on.

2. When the Administrator Login window appears, type in “root” in the Login field and enter the system password.

   **NOTE:** You must log in as a super user (root) to install a new printer to the printing system. If you are not a super user, ask your system administrator.

3. From the Startup Menu icon at the bottom of the desktop, select **Linux Printer** and then **Configuration Tool**.

   You can also access the Linux Printer Configuration window by typing in “`linux-config`” from the Terminal screen.

4. When the Linux Printer Configuration window appears, click the **Add Printer** icon on the toolbar at the top of the window.

5. Click the **Connection** tab at the top of the Add a Printer window.

   Ensure that the printer port is set properly. If it is not, change the device setting.

6. Click **OK**.

9. Click the **Connection** tab and ensure that the printer port is set properly. If it is not, change the device setting.

10. You can use the **Settings** tab and the **Queue** tab to view the printer’s current settings. If necessary, you can change the settings.

   **NOTE:** Options may differ depending on the printer in use. The **Description** and the **Location** field in the Queue screen may not appear depending on the printing system in use.

11. To exit, click **OK**.

12. When the window indicates that the new printer is successfully configured, click **OK**.

13. The Linux Printer Configuration window reappears. From the **Info** tab, you can view information about your printer driver. If necessary, you can change the printer’s configuration. For details about changing the printer’s configuration, see “Using the Configuration Tool” on page 20.
Uninstalling the Printer Driver

1. From the Startup Menu icon at the bottom of the desktop, select **Linux Printer** and then **Configuration Tool**.

   ![Configuration Tool](image1)

You can also access the Linux Printer Configuration window by typing in “`linux-config`” from the Terminal screen.

2. In the Linux Printer Configuration window, select the **Uninstall** command from the **File** menu.

3. The Administrator Login window appears. Type in “**root**” in the **Login** field and enter the system password. Click **Proceed**.

   **NOTE:** You must log in as a super user (root) to uninstall the printer software. If you are not a super user, ask your system administrator.

4. A message window asking for confirmation to proceed with the uninstallation appears. Click **Yes**.

5. Select **Complete uninstall** and then click **Uninstall**.

   ![Uninstall Tool](image2)

6. Click **OK** to begin uninstallation.

7. When the uninstallation is completed, click **Finished**.

Using the Configuration Tool

The configuration tool accesses administrative tasks, including adding and removing new printers, and changing their global settings. Regular users can also run it to easily inspect job queues, examine printer properties and changing their local preferences.

To access the Configuration Tool:

1. From the Startup Menu icon at the bottom of the screen, select **Linux Printer** and then **Configuration Tool**. The Linux Printer Configuration window appears.

   You can also open this window from the Terminal screen by typing in “`linux-config`.”

2. The Linux Printer Configuration window shows a list of installed printers in the left pane. The right pane shows a number of tabs that display information regarding the currently selected printer.

   Select your printer driver, if not currently selected.

   ![Configuration Tool](image3)

3. The **Info** tab shows general information about the printer.

   If you are an Internet user, you can click **Go to the Web page for this printer** to access the Xerox web page.

   Click the **Job** tab to inspect and manage the job queue for the selected printer. You can suspend, resume, or delete a specific job(s) in the queue. If you drag a specific job(s), you can drop it into the print queue of another printer.
The **Properties** tab allows you to change the default printer settings.

**NOTE:** Regular users are able to override the system-wide default settings defined by the administrator. When a regular user clicks **Apply**, these custom settings will be saved in the user’s profile and may be used later with LLPR. If the administrator is running the configuration tool, then the settings will be saved as the new global defaults.

### Changing LLPR Properties

You can fine-tune the printer’s properties by opening the LLPR Properties window.

To open the LLPR Properties window:

1. From the application you are using, select the **Print** command.
2. When the Linux LPR window opens, click **Properties**.

You can also open the LLPR Properties window in the following ways:

- From the Startup Menu icon at the bottom of the screen, select **Linux Printer**, and then **Linux LPR**.
- If the Linux Printer Configuration window is currently open, select **Test Print** from the **Print** menu.

The LLPR Properties window opens.

You will see the following six tabs at the top of the window:

- **General** - allows you to change the paper size, the paper type, the paper source, the orientation of the documents, enable the duplex feature, add start and end banners, and change the number of pages per sheet.
- **Margins** - allows you to specify the page margins. The graphics on the right show the current settings. These margins do not apply when printing regular PostScript data.
- **Image** - allows you to set image options that will be used when printing image files, i.e., when a non-PostScript document is passed to LLPR on the command line. Colour settings will also take effect for postscript documents.
- **Text** - allows you to select the text density and turn the syntax colouring on or off.
- **HP-GL/2** - allows you to set default options to print HP-GL/2 format documents, used by some plotters.
- **Advanced** - allows you to override the default settings for the printer.

If you click the **Save** button at the bottom of the window, the options will be retained between LLPR sessions. Use the **Help** button to view details about the options in the window.

4. To apply the options, click **OK** in the LLPR Properties window. You will return to the Linux LPR window. To start printing, click **OK**.
Your printer supports Macintosh systems with a built-in USB interface or 10/100 Base-TX network interface card.

**NOTE:** Some printers do not support a network interface. Make sure that your printer supports a network interface by referring to Printer Specifications in your Printer User’s Guide.

This chapter includes:

- Installing Software for Macintosh
- Setting Up the Printer
- Printing

### Installing Software for Macintosh

The Printer software CD that came with your printer provides you with the PPD file that allows you to use the CUPS driver for printing on a Macintosh computer.

Verify the following before you install the printer software:

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Mac OS 10.3 ~ 10.4</td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB</td>
</tr>
<tr>
<td>Free Disk Space</td>
<td>200 MB</td>
</tr>
</tbody>
</table>

**Install the Printer driver**

1. Make sure that you connect your printer to the computer. Turn on your computer and printer.
2. Insert the Printer software CD which came with your printer into the CD-ROM drive.
3. Double-click **CD-ROM icon** that appears on your Macintosh desktop.
4. Double-click the **MAC_Installer** folder.
5. Double-click the **MAC_Printer** folder.
6. Double-click the **Phaser 6110 Installer** icon.
7. Enter the password and click **OK**.
8. The Phaser 6110 Installer window opens. Click **Continue** and then click **Continue**.
9. Select **Easy Install** and click **Install**. Then click **Continue**.
10. After the installation is finished, click **Quit**.

**Uninstalling the Printer driver**

Uninstall is required if you are upgrading the software, or if installation fails.

1. Insert the Printer software CD which came with your printer into the CD-ROM drive.
2. Double-click **CD-ROM icon** that appears on your Macintosh desktop.
3. Double-click the **MAC_Installer** folder.
4. Double-click the **MAC_Printer** folder.
5. Double-click the **Phaser 6110 Installer** icon.
6. Enter the password and click **OK**.
7. The Phaser 6110 Installer window opens. Click **Continue** and then click **Continue**.
8. Select **Uninstall** and then click **Uninstall**.
9. When the uninstallation is done, click **Quit**.
Setting Up the Printer

Set up for your printer will be different depending on which cable you use to connect the printer to your computer—the network cable or the USB cable.

For a Network-connected Macintosh

NOTE: Some printers do not support a network interface. Before connecting your printer, make sure that your printer supports a network interface by referring to Printer Specifications in your Printer User’s Guide.

1. Follow the instructions on “Installing Software for Macintosh” on page 22 to install the PPD and Filter files on your computer.
2. Open Print Setup Utility from the Utilities folder.
3. Click Add on the Printer List.
4. Select the IP Printing tab.
5. Select Socket/HP Jet Direct in Printer Type.
6. Enter the printer’s IP address in the Printer Address field.
7. Enter the queue name in the Queue Name field. If you cannot determine the queue name for your printer server, try using the default queue first.
8. Select Xerox in Printer Model and your printer in Model Name.
9. Click Add.
10. Your printer’s IP address appears on the Printer List, and is set as the default printer.

For a USB-connected Macintosh

1. Follow the instructions on “Installing Software for Macintosh” on page 22 to install the PPD and Filter files on your computer.
2. Open Print Setup Utility from the Utilities folder.
3. Click Add on the Printer List.
4. Select the USB tab.
5. Select Xerox in Printer Model and your printer in Model Name.
6. Click Add.

Your printer appears on the Printer List, and is set as the default printer.
Printing

NOTES:
• The Macintosh printer’s properties window that appears in this User’s Guide may differ depending on the printer in use. However the composition of the printer properties window is similar.
• You can check your printer name in the supplied Printer software CD.

Printing a Document
When you print with a Macintosh, you need to check the printer software setting in each application you use. Follow these steps to print from a Macintosh.

1. Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Page Setup (Document Setup in some applications).
3. Choose your paper size, orientation, scaling, and other options and click OK.

4. Open the File menu and click Print.
5. Choose the number of copies you want and indicate which pages you want to print.
6. Click Print when you finish setting the options.

Changing Printer Settings
You can use advanced printing features when using your printer.
From your Macintosh application, select Print from the File menu. The printer name which appears in the printer properties window may differ depending on the printer in use. Except for the name, the composition of the printer properties window is similar.

Layout Setting
The Layout tab provides options to adjust how the document appears on the printed page. You can print multiple pages on one sheet of paper.
Select Layout from the Presets drop-down list to access the following features. For details, see “Printing Multiple Pages on One Sheet of Paper” on the next column.

▲ Mac OS 10.3
**Printer Features Setting**

The **Printer Features** tab provides options for selecting the paper type and adjusting print quality. Select **Printer Features** from the **Presets** drop-down list to access the following features:

<table>
<thead>
<tr>
<th>Printer:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presets:</td>
</tr>
<tr>
<td><strong>Printer Features</strong></td>
</tr>
</tbody>
</table>

▲ Mac OS 10.3

**Paper Type**

Set type to correspond to the paper loaded in the tray from which you want to print. This will let you get the best quality printout.

**Resolution (Quality)**

*The Resolution options you can select may vary depending on your printer model.* You can select the printing resolution. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

**Colour Mode**

You can set the colour options. Setting to **Colour** typically produces the best possible print quality for colour documents. If you want to print a colour document in Black & White, select **Black & White**.

---

**Printing Multiple Pages on One Sheet of Paper**

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way to print draft pages.

1. From your Macintosh application, select **Print** from the **File** menu.
2. Select **Layout**.
3. Select the number of pages you want to print on one sheet of paper on the **Pages per Sheet** drop-down list.
4. Select the page order from the **Layout Direction** option. To print a border around each page on the sheet, select the option you want from the **Border** drop-down list.
5. Click **Print**, and the printer prints the selected number of pages on one side of each page.

▲ Mac OS 10.3
Software section
Index

A
advanced printing, use 10

B
booklet printing 11

document, print
  Macintosh 24
  Windows 5
double-sided printing 12

E
Extras properties, set 9

F
favorites settings, use 9

G
Graphics properties, set 8

H
help, use 9

I
install
  printer driver
    Linux 18
    Macintosh 22
    Windows 3

L
Layout properties, set
  Linux 21
  Macintosh 24

Windows 6
Linux
  configuration tool 20
driver
  install 18
  uninstall 20
LLP properties 21

M
Macintosh
driver
  install 22
  uninstall 22
  printing 24
  setting up the printer 23

N
n-up printing
  Macintosh 25
  Windows 10

O
orientation, print
  Windows 6
overlay
  create 14
  delete 14
  print 14

P
Paper properties, set 7
  paper size, set 7
  paper source, set
    Linux 21
    Windows 7
  paper type, set
    Linux 21
    Macintosh 25
poster, print 11
  print
document 5
  fit to page 12
  from Macintosh 24
  from Windows 5
N-up
  Macintosh 25
  Windows 10
overlay 14
poster 13
scaling 12
watermark 13
printer properties, set
  Linux 21
  Macintosh 24
  Windows 6
printer resolution, set
  Macintosh 25
  Windows 8
printer software
  install
    Linux 18
    Macintosh 22
    Windows 3
uninstall
  Linux 20
  Macintosh 22
  Windows 3
printing
  booklets 11
double-sided 12

S
setting
  darkness 8
  favorites 9
  image mode 8
  resolution
    Macintosh 25
    Windows 8
toner save 8
true-type option 8
software
  install
    Linux 18
    Macintosh 22
Windows 3
system requirements
Linux 17
Macintosh 22
uninstall
Linux 20
Macintosh 22
Windows 3
status monitor, use 16
system requirements
Linux 17
Macintosh 22

T
toner save, set 8

U
uninstall, software
Linux 20
Macintosh 22
Windows 3

W
watermark
create 13
delete 13
edit 13
print 13